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ABSTRACT 

Surface Ship Shock trials play an essential role in ship test and evaluation (T&E), 

and Live Fire Test and Evaluation (LFT&E) requirements for the lead ship of each new 

construction shock-hardened ship class. While these trials are necessary in order to 

evaluate the vulnerability and survivability of the ship, they are very expensive, require 

extensive time for planning and coordination, and pose serious danger to the crew, ship 

and marine environment. Thus, computer modeling of the ship structure, surrounding 

fluid, and virtual shock environment by utilizing finite element method offers a valuable 

design tool and an alternative to these tests.   

This thesis investigates the response of a catamaran-hull ship subjected to an 

underwater explosion by creating a virtual UNDEX environment based on the modeling 

and simulation methodology established by the Shock and Vibration Computational 

Laboratory at the Naval Postgraduate School (NPS). In previous works, all of the 

structural models were monohull ships and there have been concerns about the feasibility 

of creating the coupled fluid and catamaran-hull model. This thesis studies the effect of 

an additional hull and gap between two hulls on the dynamic response of the ship as well 

as the effect of the charge location. 
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I. INTRODUCTION  

A. BACKGROUND  
Prior to World War II, almost all underwater explosive damage to naval ships was 

caused by contact explosions. At that time, one of the best ways to destroy a ship was to 

open a hole in the hull under the waterline by a direct hit and wait for flooding to reduce 

the stability of the ship so that the ship would sink. Aside from this, only a direct hit to a 

weapons magazine, an engine room or fuel tanks would result in the devastating loss of a 

ship.  Since the result of a contact explosion is the destruction of the ship’s structure in 

the immediate area of the explosion, only very slight effect of the explosion is transmitted 

to the other parts of the ship [Ref. 1].  

In the late 1930s, the Bureau of Ships performed experiments on small structural 

models of the naval vessels in the Norfolk Naval Shipyard in order to determine the 

underwater explosions (UNDEX) effects. In the early 1940s, the test group in the 

shipyard designed and manufactured the Underwater Explosions Barge (UEB-1) in order 

to expand the experimental testing capabilities. Several tests were made in order to learn 

how to improve the strength of the hull to withstand the severe effects of underwater 

explosions. Early in World War II, the non-contact explosion was introduced. This type 

of explosion was later found to cause severe underwater shock to the ships. When the 

non-contact underwater explosion occurred, the ship’s back was broken as it was raised 

up and then struck down into the water. As a consequence, the ship sank into the gap left 

by the explosion. Increasing the charge weight resulted in more damage to the ship. Thus, 

it was understood that a direct hit was not necessary to disable the ship capabilities. 

According to the analysis of the wartime ship losses suffered during the first half of the 

twentieth century, it was determined that the incident shock wave and gas bubble pulse 

forces caused severe structural damage and material failure, and resulted in the sinking of 

several ships [Ref. 2]. 

Research on the effects of underwater explosions was increased by the U.S. Navy 

and as a result the Underwater Explosions Research Division (UERD) was established on 

December 18, 1946, in Portsmouth, Virginia. UERD undertook experiments focused on  
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improving the resistance of the ships and submarines subjected to underwater weapons, 

evaluating the effects of underwater explosions on ships. UERD has worked with many 

other Navy and Department of Defense divisions and support contractors in executing 

full scale ship and submarine shock trials, weapons effects trials, equipment shock 

hardening and qualification tests. They also performed precision experiments with scale-

model targets and free field phenomena experiments [Ref. 2].  

During the past 50 years, ongoing research efforts in the field of UNDEX shock 

phenomena have resulted in a wide knowledge base in this phenomenon. Thus, guidelines 

and specifications were developed for the shock testing and hardening of shipboard 

equipment and systems. NAVSEA 0908-LP-000-3010A [Ref. 3] and MIL-S-901D [Ref. 

4] are examples of this guidance. The ship system design is validated through shock trials 

as required in OPNAVINST 9072.2 [Ref. 5]. The DDG-81 Ship Shock Trials, which 

were completed in the summer of 2001, are the latest set of Live Fire Testing & 

Evaluations (LFT&E) to be executed in completion of these requirements. 

The shock trials, a series of underwater explosions, are necessary in order to 

obtain a sufficient knowledge of the problem due to the complexity of the shock problem. 

The variety of equipment, the different locations of these equipments and the diversity of 

the sources of the shock itself, all contribute to the complexity of the shock trials [Ref. 1]. 

Shock measurements and observations of the response of the ship, weapons systems, 

specific equipment, and crew are made. The data obtained from the tests is recorded in 

order to assess their individual and system performance in a shock environment. After 

analyzing the data obtained from one of the ships in the same class or from a ship having 

major design changes during construction, recommendations are made for the 

modification of existing ships or for a change in the design of follow-on ships to be built 

within that same ship class. 

 Due to the difficulty and complexity associated with the conduct of the shock 

trial, these tests are very expensive and dangerous. They require comprehensive planning 

and coordination as well as sensitive equipment for measurement. Possible damage to the 

ship structure, electronics and multi-million dollar weapons systems is also an ever-

present consequence.  Although these tests give an accurate account of the system 

response, they are limited to testing only two-thirds of the ships’ design limits due to the 
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safety concerns for the ship, equipment and crew.  In the situation of the USS JOHN 

PAUL JONES (DDG-53) ship shock trials conducted in 1994, planning of the test took 

four years and involved over 50 government agencies and a shock team of 300 personnel. 

Due to the lawsuit brought by the environmentalist groups, the shock trials of DDG-53 

were postponed three months. The shock tests were executed in June 1994, but only two 

of the four planned tests could be accomplished due to rough weather and post-delivery 

schedule considerations [Ref. 6]. The cost of shock trials ranged as high as 5% of the 

$950 million delivery cost of USS JOHN PAUL JONES (DDG-53) [Ref. 7]. The cost of 

shock trials of USS WINSTON S. CHURCHILL (DDG-81) conducted in May and June 

2001 was $20million and the same limitations were also applied to these shock trials 

[Ref. 8].  

In the last few years, extraordinary advances in computer modeling and 

simulation have introduced the shock tests in a virtual shock environment in order to 

reduce some of the costs associated with the LFT&E activities [Ref. 9]. By 

accomplishing these technologies, simulations can accurately predict the initial peak 

response of a ship subjected to an underwater shock event and allow for faster 

improvements in design and less cost. Besides, the simulations can be executed beyond 

the design limits providing more design information than that obtained by real shock 

trials [Ref. 8]. Thus, creating a virtual UNDEX environment for the ship system will be 

an effective method for shock trials without harming the ship crew or the environment.  

The finite element method is used for meshing the structural and fluid model. In 

order to obtain accurate results, the finite element models must be strictly detailed and the 

surrounding fluid mesh must be coupled with the wetted surface of the structural mesh. 

Since the UNDEX environment is very complex due to the effects of cavitation, bubble 

pulse and structural whipping, the coupled fluid and structural model must be almost 

perfect. The computational time step must be very small, on the order of microseconds 

while the ship response lasts on the order of seconds. 

This method can be used during the ship design, integrating predictive results 

gained from the simulations into the final stages of the design. Making the changes while 

the ship is still in the construction phase, helps reduce the overall cost.  
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Even though this approach is not sufficiently reliable enough at this time to 

completely replace the LFT&E process, it can be used as a predictive design tool. 

Through the knowledge obtained in the virtual UNDEX environment and further 

improvements in computer processing technology, virtual shock trials may eliminate the 

requirement for the LFT&E process and the need for broad scope shots and stimulate the 

investigation of UNDEX events with the use of scalable charges located at specified 

locations related to the points of concern determined in previous shock trial simulations. 

 

B. SCOPE OF RESEARCH  
This thesis investigates the response of a catamaran-hull ship subjected to an 

underwater explosion by creating a virtual UNDEX environment based on the modeling 

and simulation methodology established by the Shock and Vibration Computational 

Laboratory at the Naval Postgraduate School (NPS). In previous works, all structural 

models were monohull ships and there have been concerns about the feasibility of 

creating the coupled fluid and catamaran-hull model. This thesis studies the effect of an 

additional hull and gap between two hulls on the dynamic response of the ship. The effect 

of the gap between the hulls will be investigated by comparing the responses of selected 

equivalent nodes on each hull.  It also investigates the effect of the standoff distance from 

the charge on the response of the model.     

The structural model is constructed using the TrueGrid finite element mesh 

generation program whereas the fluid model is generated using the ABAQUS finite 

element solver. Ship shock simulation of the Sea TENTACLE model is conducted using 

the ABAQUS/Explicit finite element analysis module. 

The results from the ship shock simulations will validate the fluid modeling and 

UNDEX analysis in ABAQUS/CAE, and provide the basis for further investigation of the 

dynamic response of the catamaran-hull ships. 
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II. UNDERWATER EXPLOSIONS  

Underwater explosions (UNDEX) occurring in the water near the ship hull are of 

great concern to naval surface ships and submarines since they can result in major hull 

damage. Analyzing this phenomenon requires understanding a complex sequence of 

events, shock wave propagation, bulk cavitation and fluid-structure interaction 

phenomena. Underwater explosions may be classified in two categories [Ref. 1]. 

a) Contact underwater explosions: This type of explosion occurs in the water 

adjacent to or in contact with the hull of the ship, such as an impact-fused torpedo hit or 

the explosion of a contact mine. These explosions result in severe local damage to the 

hull. 

b) Non-contact underwater explosions: This type of explosion occurs at a given 

distance from the ship in water that is not in contact with the hull of the ship. The 

detonation of depth charges consisting of high explosives such as HBX-1, RDX, TNT 

and PETN is an example of non-contact underwater explosions. These explosions result 

in the most serious and severe shock damage to the ships.  

Non-contact underwater explosions are the type considered in this work.  

 

A. SEQUENCE OF EVENTS  
It is very important to understand the sequence of events that occurs in the water 

as a result of an underwater explosion. The sequence begins with the detonation of a high 

explosive such as TNT, HBX-1, RDX, or PETN. After the detonation of the explosive, a 

shock wave travels through the charge material at a constant, high speed of 

approximately 25,000 ft/sec, converting the solid charge to a dense gas at great 

temperatures and pressures on the order of 3000° C and 50,000 atm pressure, without 

change in volume [Ref. 10]. This event happens very rapidly in order to prevent the 

energy from having enough time to escape. The water is assumed to be compressible and 

homogeneous in UNDEX analysis. Assuming an ideal fluid, the water in UNDEX 

analysis does not support shear stresses and no heat transfer is considered. The high 

pressure gas compresses the surrounding water, that layer of water then compresses the 
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adjacent layer, and so on. As the gas expands, the water is forced radially outward, and 

this radial flow modifies the pressure distribution at points relatively close to the bubble 

[Ref. 2]. Therefore, a shock front is propagated radially outward at a velocity that 

exceeds the velocity of sound in the uncompressed water as shown in Figure 1. 

 

 
Figure 1.   Gas Bubble and Shock Wave from an Underwater Explosion [Ref.10] 

 

A shock wave is characterized by a discontinuous change in pressure, particle 

velocity, and density in a direction normal to the front. Figure 2 shows this type of 

pressure distribution for a 300 lb TNT underwater explosion [Ref. 10]. 

 

 
Figure 2.   Shock Wave Pressure Profile for a Radially Expanding Wave From a 300 

lb TNT Charge [Ref. 10] 
 

Since the shock front is spherical, the pressure drops as the wave moves outward 

as seen in Figure 2. Thus, the resulting shock wave pressure profile is proportional to the 

inverse of the distance from the charge, 1/d.  
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Empirical equations are derived in order to characterize the shock wave pressure 

profile, P(t). These equations are accurate at distances between 10 and 100 charge radii, 

and for a duration of up to one decay constant in time after the initial detonation [Ref.10].  
1t-t-
θ

maxP(t)=P e               (psi)    (2.1) 
 

1A1
3

max 1
WP =K
R

⎛ ⎞
⎜ ⎟
⎜ ⎟⎜ ⎟
⎝ ⎠

         (psi)    (2.2) 

 
2A1

1 3
3

2
Wθ=K W
R

⎛ ⎞
⎜ ⎟
⎜ ⎟⎜ ⎟
⎝ ⎠

       (msec)   (2.3) 

 

( )

1
3

max 6 1
3

WA =K
D+33

      (ft)   (2.4) 

( )

1
3

5 5
6

WT=K
D+33

           (sec)   (2.5) 

4A

3
1

3
1

4 R
WWKE

⎟
⎟
⎟

⎠

⎞

⎜
⎜
⎜

⎝

⎛
=  (lb-in/in3)  (2.6) 

 

where Pmax = the peak magnitude of the pressure in the shock front (psi)  

 t-t1 = the time elapsed after the arrival of the shock (msec) 

 θ = the decay constant (msec) 

 R = standoff distance, radial (ft) 

 W = the weight of the explosive (lb) 

 D = charge depth (ft) 

K1, K2, K4, K5, K6, A1, A2 = constants depending on the explosive type 

Amax = maximum bubble radius (ft) 
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T = the bubble oscillation period (sec) 

E = energy per unit volume (lb-in/in3) 

The shock wave parameters are tabulated in Table 1. [Ref. 10] 

 

Table 1.   Shock Wave Parameters [Ref. 10] 
 
 CONSTANTS HBX-1 TNT PENTOLITE NUKE 

K 1  22347.6 22505 24589 4380000 
P max  

A 1  1.144 1.18 1.194 1.18 

K2 0.056 0.058 0.052 2.274 DECAY 

CONSTANT 
A 2  -0.247 -0.185 -0.257 -0.22 

BUBBLE 

PERIOD 
K 5  4.761 4.268 4.339 515 

BUBBLE 

RADIUS 
K 6  14.14 12.67 12.88 1500 

K4 3,086.5 3,034.9 3,135.2 3.313x108 ENERGY 

A4 2.039 2.155 2.094 2.04 

 

After generation of the shock wave, approximately 50% of the energy of the 

explosion is emitted in the shock wave. Since the bubble uses about half of the energy, 

the bubble pulse pressure can result in as severe damage as the shock wave itself. The gas 

bubble loses energy by the radiation. The shock wave moves outward as long as the gas 

bubble pressure is higher than hydrostatic pressure using its own energy. At some time, 

the gas pressure drops to the hydrostatic pressure prior to the explosion at some time 

when the gas bubble reaches its maximum diameter. Since the adjacent water still has an 

outward velocity, the gas bubble does not rest and continues to expand until the pressure 

becomes smaller than hydrostatic pressure. At this instant, the gas bubble reaches its 

maximum radius and the internal energy of the gas bubble is so small that it can be 
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neglected. Equation (2.4) is used to determine the maximum gas bubble radius. As shown 

from Equation (2.4), the maximum bubble diameter mostly depends on the charge type, 

depth and weight.  

After reaching the maximum radius, the gas bubble pressure becomes so small 

that the hydrostatic pressure causes the gas sphere to be contracted and recompressed to a 

high pressure determined by the inward velocity of the water at the time the pressure 

returns to the hydrostatic pressure. Due to this recompression, a second wave forms and 

radiates into the water. The second bubble again reaches its equilibrium state and a 

maximum radius which is smaller than initial maximum radius. The gas sphere undergoes 

several compressions and re-expansions until it loses all of its energy or the bubble 

reaches the surface of the water [Ref. 1]. Figure 3 shows the oscillation of the gas bubble 

[Ref. 10]. 

 
Figure 3.   Migration Pathway and Gas Bubble Oscillation [Ref. 10] 
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The gas bubble oscillation period can be calculated by Equation (2.5). As shown 

in Figure 3, the peak pressure of the shock wave is very big and decays very rapidly. Due 

to the energy loss, the maximum pressure of first bubble pulse is approximately 10-20% 

of shock wave pressure [Ref. 11]. The shock wave energy depends on the charge 

properties and standoff distance. Equation (2.6) is used to determine the shock wave 

energy. 

Gravity has an important effect on bubble migration. It causes the gas bubble to 

migrate upward while it rises due to the buoyancy of the bubble [Ref. 10]. Using the 

impulse-momentum change theorem, the vertical bubble velocity (U) can be calculated 

by using Equation (2.7) 

∫=
t

0

3
3 )t(a

)t(a
g2U  (ft/sec)   (2.7) 

where  g = gravitational acceleration constant 

 a = gas bubble radius 

  Since the vertical bubble velocity is proportional to the inverse of the third power 

of the bubble radius, it can be stated that the bubble rises faster when its size is minimum.  

 As seen in the empirical equations, the charge depth is of considerable interest. In 

shallow water, the gas pressure is less than atmospheric pressure when the gas bubble 

radius is about maximum. The air enters in the cavity very rapidly when the gas bubble 

reaches the surface and acts as a cushion in order to allow the closure and eliminate any 

closure pressure pulse. Therefore, it can be stated that the explosion depth should be less 

than the maximum bubble radius. The results will be acceptable if the charge depth is 

between 50% and 80% of maximum radius. [Ref. 10]  

 

B. CAVITATION 
Cavitation is defined as the phenomenon that occurs in water led by the reflection 

of a shock wave at the surface. A tensile reflected wave, which is called rarefaction wave, 

occurs when the compressive shock wave is reflected from the free surface. Water cannot 

support the tensile force and cavitation occurs, leading to a pressure rise up to the vapor 
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pressure of water. There are two types of cavitation in an UNDEX event: bulk cavitation 

and local cavitation. Bulk cavitation can be regarded as the large area of low pressure at 

the free surface whereas local cavitation can be regarded as the small area of low pressure 

occurring at the fluid-structure interface. Cavitation has a tremendous effect on the 

overall response of the surface ships so that it must be taken into consideration in the 

simulation process [Ref. 12]. 

 

1. Bulk Cavitation  
In an UNDEX event, a three-dimensional spherical pressure wave forms and 

propagates outward from the detonation center. The underwater explosion attack 

geometry is shown in Figure 4. In an UNDEX event, the incident shock wave, which is 

compressive and the strongest wave, hits the target first and reaches the free surface. The 

rarefaction wave is formed by the reflection of the incident shock wave at the free 

surface. The direction of the rarefaction wave is opposite to the direction of propagation. 

Since the air-water interface is not a rigid boundary, it occurs as a tensile wave and poses 

a tensile force to water. As stated before, the water cannot support the tensile force and 

forms cavities which are filled with water vapor.  The vapor pressure of water is about 

0.3 psi. The rarefaction wave reaches the image after the incident wave as illustrated in 

Figure 5. After the arrival of the rarefaction wave, the pressure drops to zero or negative 

value. This is called “cut-off” in the pressure.  The cavitation pressure is a negative 

pressure of three to four psi [Ref 13]. 

A bottom reflection wave is also formed due to the reflection of the shock wave at 

the sea bottom. However, this type of wave is of less interest in an UNDEX event due to 

the dependence on the sea bottom characteristics and its closeness to the target [Ref. 10]. 
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Figure 4.   Underwater Explosion Geometry [Ref. 10] 

 

 
Figure 5.   Shock Wave Pressure Profile with Cut-off [Ref. 10] 

 

The cavitated region formed by the rarefaction wave is called the bulk cavitation 

zone. It consists of two boundaries: the upper cavitation boundary and the lower 

cavitation boundary. The upper cavitation boundary is the region where the net pressure 

due to incident and reflected waves is zero. In point of fact, the net pressure below the 

surface is not zero at the cut-off time. The calculated net pressure may be less than zero 
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depending on the depth. As stated before, cavitation occurs where the total pressure is 

negative. Total pressure consists of compressive incident wave pressure, tensile 

rarefaction wave pressure, atmospheric pressure and hydrostatic pressure. Equation (2.8) 

with Equation (2.9) and (2.10) is used to determine the upper cavitation boundary by 

setting the total pressure to zero. 
1 1

2 1

1 1
( )3 3

1 1
1 2

( , ) 0

A A
r r
C

A
W WF x y K e P y K
r r

θ γ
−

−
⎛ ⎞ ⎛ ⎞
⎜ ⎟ ⎜ ⎟= + + − =⎜ ⎟ ⎜ ⎟⎜ ⎟ ⎜ ⎟
⎝ ⎠ ⎝ ⎠

 (2.8) 

 

2 2
1 ( )r D y x= − +   and  2 2

2 ( )r D y x= + +   (2.9) and (2.10) 
 
 

where  x,y = the horizontal range and vertical depth of the point 

 r1 = standoff distance from the charge to the point 

 r2 = standoff distance from the image charge to the point 

 C = acoustic velocity in the water 

 D = charge depth 

 θ = decay constant (Equation (2.3))  

 PA = atmospheric pressure 

 γ = weight density of water 

 W = charge weight 

 K1, A1 = shock wave parameters (see in Table 1) 

The lower cavitation boundary is determined by equating the decay rate of 

breaking pressure and the decay rate of absolute pressure. The breaking pressure is 

defined as the rarefaction wave pressure that reduces the absolute pressure to the 

cavitation pressure [Ref. 10]. Equation (2.11) with Equation (2.12) is used to determine 

the lower cavitation boundary.  
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2 1( )

max

r r
C

iP P e θ
−⎡ ⎤−⎢ ⎥⎣ ⎦=    (2.12) 

where Pi = incident wave pressure at cut-off 

 A1, A2 = shock wave parameters (see in Table 1) 

 The MATLAB® code is used to determine these boundaries and plot the zone by 

solving the Equation (2.8) and (2.11). The results of the code depend on the user’s input 

and analysis type. The code is provided in Appendix A.   

The cavitation boundaries are highly dependent on the charge type, weight and 

depth as seen in the equations. Figure 6 illustrates that the charge depth has a very 

important effect on the cavitation region as stated before. The plots are generated for 150 

lb Trinitrotouluene (TNT) charge at varying depths. As shown in Figure 6, the cavitation 

region (shown in red) stretches as the charge depth increases and the vertical depth of the 

region decreases due to the stretching. Therefore, the cavitation area is the largest when 

the charge is at 75 ft for a 150 lb charge. As a consequence, it can be stated that the 

cavitation area increases with increasing charge depth. 

 

 

 

 

 

 

 

 



15 

 
Figure 6.   Bulk Cavitation Zone for 150 lb TNT Charge Detonated at Varying 

Depths 
 

Figure 7 illustrates the effect of charge weight on the bulk cavitation zone. The 

plots are generated for HBX-1 at 50 ft depth with varying weights. As shown in Figure 7, 

the cavitation region for 300 lb HBX-1 is the largest, and the region for 100 lb the 

smallest, among them. It can be stated that the cavitation area increases with increasing 

charge weight while the region stretches. These effects can be combined such as 

increasing the weight but decreasing the depth. The cavitation region certainly changes 

due to the combined effects. 
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Figure 7.   Bulk Cavitation Zone for HBX-1 Charge Detonated at 50 ft with Varying 

Weights 

 

Figure 8 illustrates the effect of charge type on the bulk cavitation zone. The plots 

are generated for TNT and HBX-1 charges detonated at the same depth (25 ft) and weight 

(200 lb). Each charge type has different shock wave coefficients that affect the cavitation 

region. Since the coefficients of HBX-1 are close to those of TNT, it is difficult to 

determine which explosive creates a larger cavitation area. 

As shown in Figure 8, the cavitation region is more stretched when the TNT 

charge is used. For this situation, it can be stated that the cavitation region stretches when 

a charge having bigger Pmax and decay constant coefficients is used. Many trials have 

been made in order to check the accuracy of this statement. For instance, increasing the 

charge depth gives the opposite result. For larger depths, the cavitation region is more  
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stretched when HBX-1 is used. Therefore, for larger depths it can be stated that the 

cavitation region increases when a charge having smaller Pmax and decay constant 

coefficients is used.  

The results for several trials are tabulated in Table 2 where the charge type that 

creates a larger cavitation region depending on the charge weight and depth is shown.  

 
Figure 8.   Bulk Cavitation Zone for 200 lb HBX-1 and TNT Charge Detonated at 25 ft 

 

 

Table 2.   Comparison of TNT and HBX-1 Charges 
 

Charge Depth (ft) Charge 
Weight (lbs) 10 30 50 100 200 
25 TNT TNT HBX-1 HBX-1 HBX-1 
50 TNT TNT TNT HBX-1 HBX-1 
100 TNT TNT TNT HBX-1 HBX-1 
200 TNT TNT TNT TNT HBX-1 
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As shown in Table 2, the cavitation region is greater when the TNT charge is used 

in shallow water. Otherwise, the cavitation region is greater when the HBX-1 charge is 

used. As a consequence, the charge types affect the cavitation region due to their shock 

wave parameters. 

Although the plots exhibit a two-dimensional bulk cavitation region, it is actually 

a three-dimensional one that is generally symmetric about an imaginary vertical axis 

passing through the charge as shown in Figure 9. The shape of the bulk cavitation zone is 

similar to a cardioid just below the air-water interface. The bulk cavitation zone in Figure 

9 is created by 100 lb Pentaerythritol Tetranitrate (PETN) at 75 feet depth [Ref 14].  

 

 

 

 

 

 
Figure 9.   Bulk Cavitation Zone in an UNDEX event [Ref. 14] 

 

The vertical kick-off velocity of the surface ship can be determined by the fluid 

particle velocities near the free surface. According to Archimedes Law, the water particle 

velocity near the free surface is equal to the vertical kick-off velocity of the ship. After 

determining the centerline, the calculated water particle velocity can be used as an 

average vertical kick-off velocity of the ship.  

 

2. Local Cavitation 
Local cavitation is the phenomenon that occurs at the fluid-structure interface due 

to the results of the interaction of the pressure pulse and the flexible surface of the 

structure. The shock pressure pulses that are produced by an UNDEX event excite the 

ship causing dynamic responses while they impinge on the ship and a fluid-structure  

 

 

  

Charge 
Bulk Cavitation 
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interaction occurs. Total pressure turns out to be negative along the hull. Since the water 

cannot support tensile pressure, the water pressure drops to the vapor pressure of water 

and local cavitation occurs.  

Taylor flat plate theory, which was presented by G. I. Taylor, is the simplest fluid-

structure interaction example. In this theory, an infinite, air-backed plate is used as the 

hull in order to illustrate the reaction of the hull subjected to the shock wave, as shown in 

Figure 10.  

 
Figure 10.   Taylor Plate Subjected to a Plane Wave [Ref. 10] 

 

As shown in Figure 10, the Taylor plate is subjected to the incident plane shock 

wave of pressure 1( )P t . After interacting with the plate, the reflected plane shock wave of 

pressure 2( )P t is created and reflected off the plate. According to Newton’s 2nd Law, the 

equation of motion of the plate can be written as  

 

 1 2
( ) ( ) ( )du tm P t P t

dt
= +  (2.13) 

 

where  m = the mass of the plate per unit area 

 u(t) = the velocity of the plate 



20 

The velocities of the fluid particle behind the incident and reflected shock waves 

are defined as 1( )u t and 2 ( )u t , respectively. Thus, the velocity of the plate can be defined 

as  

 
 1 2( ) ( ) ( )u t u t u t= − . (2.14) 

For one-dimensional incident and reflected shock waves, the wave pressures can 

be expressed as  

 
 1 1( ) ( )P t Cu tρ=  (2.15) 
 
 2 2( ) ( )P t Cu tρ=  (2.16) 
 

where ρ  = the fluid density 

 C = the acoustic velocity  

 Substituting Equations (2.15) and (2.16) into Equation (2.14) gives the 

relationship between the plate velocity and shock wave pressures.  

 

 1 2
1 2

( ) ( )( ) ( ) ( ) P t P tu t u t u t
Cρ

−
= − =  (2.17) 

 

The incident shock wave pressure 1( )P t can be calculated by using Equation (2.1).  

Equation (2.1) is substituted into Equation (2.17) in order to obtain an expression for the 

reflected wave pressure 2( )P t . 

 

 
1

2 max( ) ( )
t t

P t P e Cu tθ ρ
−⎛ ⎞−⎜ ⎟

⎝ ⎠= −  (2.18) 
 

 The equation of motion, Equation (2.13) can be rewritten by substituting Equation 

(2.18). 

 

 
1

max( ) 2
t tdum Cu t P e

dt
θρ
−⎛ ⎞−⎜ ⎟

⎝ ⎠⎛ ⎞ + =⎜ ⎟
⎝ ⎠

 (2.19) 
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Equation (2.20) is determined after solving the first order linear differential 

equation, Equation (2.19). 

 

 
1 1( ) ( )

max2( )
(1 )

t t t tPu t e e
m

β
θ θθ

β

− −⎡ ⎤ ⎡ ⎤− −⎢ ⎥ ⎢ ⎥⎣ ⎦ ⎣ ⎦
⎧ ⎫⎪ ⎪= −⎨ ⎬− ⎪ ⎪⎩ ⎭

 (2.20) 

 

where C
m

ρ θβ =  and 0t > . Since the expression for the plate velocity is defined, the 

reflected shock wave pressure 2( )P t  and the net pressure at the plate can be described as 

 

 
1 1( )

max
2 ( ) (1 ) 2

1

t t t tPP t e e
β

θ θβ β
β

− −⎛ ⎞ ⎡ ⎤− −⎜ ⎟ ⎢ ⎥⎝ ⎠ ⎣ ⎦
⎡ ⎤
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 (2.21) 
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2 2

1 1

t t t t

P P P e e
β
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 (2.22) 

 

As shown in Equation (2.20), the net pressure becomes negative at a very early 

time as β increases, which correlates to a lightweight plate. Local cavitation occurs when 

the tensile pressure turns out to be the vapor pressure of water and separates the plate 

from the water [Ref. 10]. The plate has maximum velocity at the cut-off time when the 

pressure in front of the plate occurs. The time at which the plate reaches its maximum 

velocity, 0t  can be determined by setting Equation (2.22) equal to zero and solving for t .  

 

 0
ln

1
t β θ

β
=

−
 (2.23) 

 

 The maximum velocity of plate, umax can be expressed by substituting 0t  into 

Equation (2.20).  
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The equations used in the Taylor plate theory are appropriate up to the beginning 

of the cavitation.  After cavitation begins, the problem turns into a nonlinear and non-

conservative problem and the equations are no longer valid.  For light plate weights, a 

second loading occurs and increases the plate velocity due to the fact that the momentum 

of the light plate is equal to a fraction of the impulse in the shock wave.  This loading can 

be more extreme than the first loading.   

 

C. FLUID-STRUCTURE INTERACTION 
The fluid-structure interaction between the water and the hull due to the 

underwater explosion mainly occurs in the vertical direction. Since the shock wave 

impinges on the ship hull causing dynamic responses on the ship structure, the fluid-

structure interaction has a great importance in an UNDEX event.  

A matrix of differential equations is used to determine the approximate response 

of the ship with some acceptable degree of accuracy. This approximation is called the 

Doubly Asymptotic Approximation (DAA) and is applicable at both low and high 

frequencies and at early and late times [Ref. 12]. Equation (2.25), the discretized 

differential equation, defines the dynamic response of the ship structure. 

 
 [ ]{ } [ ]{ } [ ]{ } { }sM x C x K x f+ + =&& &  (2.25) 
 

where  { }x = the structural displacement vector 

 [ ]sM  = the structural mass matrix 

 [ ]C  = the structural damping matrix 

 [ ]K  = the structural stiffness matrix 

 { }f = the applied force vector 

 dots indicate the temporal derivative 

As shown in Equation (2.25), the inertial forces, damping forces, internal forces 

and acoustic fluid pressure forces serve to set up the equilibrium configuration for the 

system [Ref. 15].  
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For a submerged structure evoked by an acoustic wave, the external forcing 

function can be expressed as, 

 
 { } [ ][ ]({ } { }) { }f I S Df G A p p f= − + +  (2.26) 
 

where { }Ip = the nodal pressure vector for the wetted-surface fluid mesh pertaining to  

the incident wave  

 { }Sp = the nodal pressure vector for the wetted-surface fluid mesh pertaining to 

the scattering wave 

 { }Df = the dry-structure applied force vector  

 [ ]G = the transformation matrix relating the nodal surface forces  

 [ ]fA  = the diagonal area matrix associated with the elements in the fluid mesh 

[Ref. 16]. 

The fluid-structure interaction problem in terms of wet-surface response can be 

solved by using the DAA. Since it is not applicable in the cavitation region, The First 

Order Doubly Asymptotic Approximation (DAA1), which is expressed by Equation 

(2.27), is used for the long cylindrical shell structures such as surface ships or submarines 

[Ref. 17]. The DAA1 is exact if the shell structure is spherical. 

 
 [ ]{ } [ ]{ } [ ]{ }f S f S f SM p c A p c M uρ ρ+ =& &  (2.27) 
 

where { }su = the scattered wave fluid particle velocities vector normal to the structure’s 

wetted surface 

 [ ]fM  = the fluid mass matrix  

 ρ  = the fluid mass density 

 c = the acoustic velocity of the fluid.  
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 The fluid mass matrix [ ]fM  is produced by a boundary-element treatment of 

Laplace’s equation for the irrotational flow that is generated in an infinite, inviscid and 

incompressible fluid. 

For the high frequency response, the Equation (2.27) can be expressed by a plane 

wave approximation as s sp cuρ= . However, for the low frequency response, it can be 

expressed as f s f sA p M u= &  by using a virtual mass approximation [Ref. 18].  

Since the problem is solved in terms of wet-surface response, the excitation of the 

wetted surface structure by an incident shock wave, { }f  is given by Equation (2.28) 

[Ref. 19]. 

 

 { } [ ][ ]({ } { })f I Sf G A p p= − +  (2.28) 
 

The compatibility relation on the wetted surface of the structure, Equation (2.29) 

can be used to correlate the scattered wave fluid particle velocities to the structure 

response  

 
 [ ] { } { } { }T

I SG x u u= +&  (2.29) 
 

where T represents matrix transpose. 

The DAA Interaction Equations are created by combining Equation (2.25) 

through Equation (2.29). 

 
 [ ]{ } [ ]{ } [ ]{ } [ ][ ]({ } { })s f I SM x C x K x G A p p+ + = − +&& &  (2.30) 

 
 [ ]{ } [ ]{ } [ ]([ ] { } { })T

f S f S f IM p c A p c M G x uρ ρ+ = −& && &  (2.31) 
 

The two unknown quantities, x and Sp in Equations (2.30) and (2.31) can be solved by 

using a staggered solution scheme [Ref. 16].   
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III. MODELING 

A. SEA TENTACLE MODEL 

1. Structural Model 
The 2005 Naval Postgraduate School Total Ship Systems Engineering (TSSE) 

interdisciplinary team design, “Sea TENTACLE”, which has capabilities of anti-

submarine warfare (ASW) and mine warfare (MIW), was used as the structural model 

basis for the investigation undertaken in this thesis work. Sea TENTACLE has a 

catamaran hull form that reduces the wave resistance due to the distribution of the 

displacement between the two hulls and increases stability in the ship’s roll response 

[Ref. 20]. Sea TENTACLE is shown in Figure 11 and the ship hydrostatic characteristics 

are tabulated in Table 3. 

 

 
Figure 11.   Sea TENTACLE [Ref. 20] 
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Table 3.   Hydrostatics Characteristics of Sea TENTACLE [Ref. 20] 

 

The model of Sea TENTACLE was created by using the Computer Aided Design 

(CAD) tool RHINO 3.0.  The structural model was imported as an IGES file into the 

finite element mesh generation program TrueGrid [Ref. 21] in order to generate the 

structural mesh. The mesh generation of the structural model using TrueGrid is explained 

in Appendix C. The final structural mesh is shown in Figure 12.  

 
Figure 12.   The structural mesh of Sea TENTACLE model 

Draft Amidsh. m 5.198 LCB from Amidsh. (+ve fwd) m -0.888 
Displacement tonne 7023 LCF from Amidsh. (+ve fwd) m -0.816 
Heel to Starboard degrees -0.51 KB m 2.965 
Draft at FP m 5.251 KG fluid m 5.925 
Draft at AP m 5.144 BMt m 19.005 
Draft at LCF m 5.197 BML m 260.973 
Trim (+ve by stern) m -0.107 GMt m 16.046 
WL Length m 117.442 GML m 258.014 
WL Beam m 24.553 KMt m 21.969 
Wetted Area m^2 3268.975 KML m 263.937 
Waterpl. Area m^2 1664.682 Immersion (TPc) tonne/cm 17.066 
Prismatic Coeff. 0.925 MTc tonne.m 154.523 

Block Coeff. 0.746 
RM at 1deg = GMt.Disp.sin(1) 
tonne.m 1966.81 

Midship Area Coeff. 0.806 Max deck inclination deg 0.5 
Waterpl. Area Coeff. 0.964 Trim angle (+ve by stern) deg -0.1 
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The model is consistent with the dimensions of Sea TENTACLE and hull form. 

The main dimensions of the structural model are illustrated in Figure 13 and 14.  

 

 

Figure 13.   Transverse View of Structural Model (the dimensions are in meters) 
 
 

 
Figure 14.   Longitudinal View of Structural Model (the dimensions are in meters) 

 

The model consists of 12 athwartship bulkheads and 50 compartments as shown 

in Figure 15.  

 

 

2nd Deck

1st Deck

Main Deck

1st Platform

2nd Platform
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Figure 15.   Arrangement of Sea TENTACLE Model 

 

Since the structural model is consistent with the dimensions and hull form of Sea 

TENTACLE, the displacement of the model is determined as 7,000 tons using the value 

of 1.025 3MTON/m  for the seawater weight density whereas the displacement of Sea 

TENTACLE is 7023 tonnes. The shell plating was constructed of 14 mm high-strength 

steel SAE 942X having a mass density of 7850 kg/m3, a Young's Modulus of 200x109 Pa, 

and a Poisson's ratio of 0.33. The shell elements were constructed as square hexagonal 

elements having a length of 1 m. The same material was also used for the structural beam 

elements (stiffeners) which are of rectangular cross section. The specifications of the 

model materials are shown in Table 4. 
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Table 4.   Material Specifications 

 

Material Type High-Strength Steel SAE 942X 

Material Model Isotropic Material (elastic) 

Young’s Modulus 200 x 109 Pa 

Poisson’s Ratio 0.33 

Thermal Expansion Coefficient 12.3 x 10-6 

Mass Density 7850 kg/m3 

Mass Damping 19.2 

Stiffness Damping 2.09 x 10-6 

 

The beam elements were used to increase the plating rigidity. In order to make the 

model realistic, the beams at the hull, having a size of 14 mm wide and 15 cm high, were 

created thicker than the beams at the superstructure having a size of 12 mm wide and 15 

cm high. Figure 16 illustrates the beam cross section while Figure 17 and 18 show the 

beam elements of the model. The overall finite element mesh of the structural model 

consists of 11202 nodes, 12300 quadrilateral (4-noded) shell elements, 13870 beam 

elements and 7774 lumped masses.  Table 5 summarizes the model particulars.  

The structural mesh of the model was output in ABAQUS input file format after 

the generation in TrueGrid. The input deck was then read into an ABAQUS database 

which is a powerful software application for advanced finite element analysis. 

ABAQUS/CAE is a complete ABAQUS environment that provides a simple, consistent 

interface for creating, submitting, monitoring, and evaluating results from 

ABAQUS/Standard and ABAQUS/Explicit simulations. Thus, ABAQUS/CAE was used 

to create the fluid mesh, couple it with the structural mesh and execute the modal analysis 

due to an UNDEX pressure wave. ABAQUS also provides a capability for bringing in 

generalized forces on acoustic and solid media related to the arrival of shock waves [Ref. 

22]. 
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Table 5.   Sea TENTACLE Model Specifications 

 
Length 117.48 m 

Beam 25 m 

Depth 16.48 m 

Draft (Design Waterline) 4.73 m 

Shell Plating/Beam Element Material  High-Strength Steel SAE 942X 

Shell Plating Thickness 14 mm 

Beam Element Dimensions (Height x Width)  

- Beam Elements at Hull 14x150 mm2 

- Beam Elements at Superstructure         12x150 mm2 

Number of Parts 18 

Number of Nodes 22126 

Number of  Shell Elements 21832 

Number of Beam Elements 36056 

 

 
Figure 16.   Beam Cross Section (the dimensions are in millimeters) 

12 14 

150 150 
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Figure 17.   Beam Elements of the Model 

 

 
Figure 18.   Beam Elements of the Hull 
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After outputting the structural model to ABAQUS, the total 6600 MT point 

masses were distributed along the deck according to Figure 19. The mass distribution 

includes the lightship mass, the payload and the fluid mass (fuel, oil, water etc.). 

 

Figure 19.   Mass Distribution of the Model 

 

2. Fluid Mesh Modeling 
Creating the fluid mesh (fluid volume finite element model) was the next step in 

the Sea TENTACLE model. The fluid part was created by using the CAD tool RHINO 

3.0 and imported as an SAT file into ABAQUS in order to generate the fluid mesh. The 

fluid part was modeled as a closed solid. The Boolean Subtract feature of RHINO 3.0 

was used to create the wetted surface in the fluid mesh using the solid hull parts. The 

fluid part was created as an ellipsoid, because the fluid domain needs to enclose the 

structure in order to use the infinite elements if needed. The fluid mesh generation using 

 

 

 

Each Hull : 2028 MT 

1st Deck : 1044 MT  

Main Deck : 1500 MT 
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ABAQUS is explained in Appendix C. The final fluid mesh is shown in Figure 20. The 

fluid part was meshed with 4-node AC3D4 acoustic tetrahedral elements in ABAQUS. 

The mass density and the acoustic speed of these solid elements have the values of 1025 

kg/m3 and 1500 m/sec, respectively. 

 
Figure 20.   Fluid Mesh in ABAQUS 

 

In order to create the ellipsoid fluid part, two quarter spheres and half cylinder 

with a radius of 25 m, which is greater than the depth of the computed bulk cavitation 

zone, were used in RHINO 3.0. Figure 21 illustrates the dimension of the fluid mesh. 

The shock analysis in ABAQUS requires a surface-based interaction for coupled 

acoustic-structural analysis. The acoustic structural coupling between the fluid mesh and 

the structural mesh at the common wetted interface was achieved by using the *TIE 

constraint option in ABAQUS. The coupling procedure and *TIE option is described in 

detail in Appendix D.  Figure 22 shows the coupled fluid-ship model. 

Free Surface 
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Figure 21.   Dimensions of the Fluid Mesh (in meters) 

 
 
 

 
Figure 22.   Coupled Fluid-Structural Mesh 

 
 
 

12.75 
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Table 6 lists the number of elements and element type created for the fluid mesh 

and structural mesh. As shown from Table 6, the fluid mesh is a large and complex mesh 

for a relatively small structure due to the cavitation effects. Thus, computational power is 

required to run a shock simulation involving a fluid mesh. 

 

Table 6.   Coupled Fluid-Structural Mesh Specifications 
 
 Number of Elements Element Type 
Fluid Mesh 607496 AC3D4 solid acoustic 

tetrahedral finite element  
Structural Mesh 21832 S4R shell quadrilateral 

finite element 
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IV. SIMULATION 

A. MODELING AND SIMULATION PROCESS 
The modeling and simulation process involves model construction, pre-

processing, analysis and solution, and post-processing of the results. Figure 23 shows a 

flowchart of the procedure used for the Sea TENTACLE UNDEX simulation. 

 

 
Figure 23.   Modeling and Simulation Flow Chart 

 
 
B. SHOCK SIMULATION WITH ABAQUS 

ABAQUS consists of two main analysis products: ABAQUS/Standard and 

ABAQUS/Explicit. ABAQUS/Standard is a general purpose analysis product that can 

solve linear and nonlinear problems involving the static, dynamic, thermal and electrical 

response of components. It solves a system of equations implicitly at each increment 

TrueGrid® 
 

ABAQUS/CAE 

ABAQUS/Standard 
ABAQUS/Explicit 

ABAQUS/Viewer 
UERD Tools 

Model Construction 
and 

Pre-Processing 

Analysis 
and 
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Post-Processing 
and 

Data Extraction 
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whereas ABAQUS/Explicit finds a solution forward through time in small time 

increments without solving a coupled system of equations at each increment [Ref. 22]. 

ABAQUS/Explicit is a special purpose analysis product that uses an explicit 

dynamic finite element formulation. It is convenient for modeling transient dynamic 

events, such as blast, acoustic and shock problems. It is also very efficient for highly 

nonlinear problems involving changing contact conditions [Ref. 22]. 

ABAQUS/CAE (Complete ABAQUS Environment) is an interactive, graphical 

environment for ABAQUS incorporating the analysis modules into a Complete 

ABAQUS Environment for modeling, managing, and monitoring ABAQUS analyses and 

visualizing results. It allows the models to be created easily and quickly by producing or 

importing the geometry of the structure and dividing it into meshable regions. Physical 

and material properties can be assigned to the model, as can loads and boundary 

conditions. Once the model is complete, ABAQUS/CAE can submit, monitor and control 

the analysis jobs. ABAQUS/Viewer is a part of ABAQUS/CAE that contains only post-

processing capabilities [Ref. 22]. 

ABAQUS provides a capability for introducing generalized forces on acoustic and 

solid media associated with the arrival of dilatational waves. This applies to shock 

problems. Since the fluid mechanics are assumed to be linear, the wave fields in the fluid 

can be superimposed in a dynamic problem excited by a propagating wave in the fluid 

arriving from outside the domain. Therefore, the observed total pressure in the fluid can 

be divided into two components--the known incident and the wave field--due to the 

reflections at the fluid boundaries and interactions with the structure. The wave field, 

referred to as the scattered field, can be calculated by applying loads at the fluid-structure 

interface [Ref. 22]. 

In ABAQUS, the shock analysis of a structure includes acoustic finite elements to 

model the effects of the mass of the fluid and incident wave loading to model UNDEX 

effects on the structure interacting with fluid. The explosive load is defined with an 

incident wave load. The load is applied on both the structure and the fluid at the common 

interface and is similar to a distributed load. These loads are supported only on transient 

dynamic procedures. 
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There are two acoustic wave formulations for shock analysis in ABAQUS: total 

wave formulation and scattered wave formulation. The scattered wave formulation is 

generated by capitalizing on the fact that the acoustic medium is linear. The model 

response can be divided into the sum of incident wave and the scattered field and is the 

response of medium to wave loads, not the wave pulse itself. The pressure in this 

formulation is the scattered pressure only [Ref. 22]. 

Total wave is simply the sum of the incident and the scattered waves. The 

mechanical behavior of the model is nonlinear when the cavitation exists. In this case, 

with the superposition of the incident wave and the responses of the model due to the 

boundaries, the cavitating regions are not valid. The total pressure in the total wave 

formulation includes the effects of the incident wave field and the overall model’s 

response. The total wave formulation presents a complete solution of the acoustic 

pressure field. When the acoustic medium is capable of cavitation, a total wave 

formulation must be used. The total wave formulation was used in the Sea TENTACLE 

model since the cavitation was of considerable interest and cavitation limit was invoked 

as zero pressure by using the keywords editor. Therefore, the pressure was cut off at zero. 

In the total wave formulation, the loading must be specified only on the fluid surfaces 

that have a nonreflecting radiation condition. ABAQUS ensures that the radiation 

condition is applied only on the scattered response and not on the incident wave [Ref. 

22]. 

ABAQUS also tracks the gas bubble migration and stops the analysis if the 

bubble reaches the free surface before the end of the analysis. The formulation used for 

determining the bubble time histories is based on the Geers-Hunter bubble model and 

exhibits the effects of the radially expanding and upwardly migrating gas bubble. The 

results were obtained by using ABAQUS/Standard for the Sea TENTACLE model. The 

parameter value BUBBLE was invoked by using the keywords editor of ABAQUS/CAE. 

ABAQUS/Viewer and Underwater Explosions Research Department (UERD) 

Tools were used as the post-processing and data extraction tools. ABAQUS/Viewer 

allows the user to view the deformed shape plots, contour plots, animations and X-Y 

plots. It was especially used for the animation and contour plot purposes in this thesis. 
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UERD which is a RTD&E organization in the Naval Surface Warfare Center, Carderock 

Division created the data analysis and plotting program specifically for the analysis of 

ship shock trial data. UERD Tools was used for X-Y plots and shock spectra since it is 

capable of importing ASCII history files exported from ABAQUS.  

The simulation process using ABAQUS/CAE is described in full detail in 

Appendix D. 

 

C. TEST DESCRIPTION OF THE ANALYSIS 
The shock trials consist of two different geometries (labeled as SHOT-1 and 

SHOT-2) for the charge location. These test geometries were based on typical full ship 

shock tests but adapted to the appropriate size of the Sea TENTACLE model to be 

investigated. A 7500 lb TNT charge was used for UNDEX analysis of the Sea 

TENTACLE model. UNDEX analysis is tracked beginning at the stand-off point, so it is 

desirable to have the stand-off point located as close to the structure as possible in 

ABAQUS [Ref. 22].  Therefore, the stand-off point was located at the intersection of the 

midship section of the structural model and the centerline of the port hull for both shots.  

1. The Attack Geometry of SHOT-1 

The attack (shot) geometry in Figures 24 and 25 was used in the shock simulation 

of SHOT-1 during the analysis. The offset distance from the stand-off point and the 

charge depth were set to 100 m and 57 m, respectively. The standoff distance was 

calculated as 113 m.   
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Figure 24.   Sea TENTACLE Model Shot-1 Geometry (Transverse View) 

 

 
Figure 25.   Sea TENTACLE Model Shot-1 Geometry (Longitudinal View) 

 

The UNDEX parameters with the distances given were calculated and tabulated in 

Table 7.  The bulk cavitation zone for the Sea TENTACLE model was calculated by 

inputting the computed UNDEX parameters and the shot geometry to the MATLAB 
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program in Appendix A. The largest depth in which the bulk cavitation occurs was 

determined as 16 m by using the MATLAB program. The bulk cavitation region is 

illustrated in Figure 26. 

 

Table 7.   UNDEX Parameters for Sea TENTACLE Model SHOT-1 Simulations 
 

Pmax 700 psi 

θ 1.956 msec 

T 0.93 sec 

 

 
Figure 26.   Bulk Cavitation Zone for SHOT-1 

 
 
 

2. The Attack Geometry of SHOT-2 

The attack (shot) geometry in Figures 27 and 28 was used in the shock simulation 

of SHOT-2 during the analysis. The charge depth was set to 155.25 m and no horizontal 

offset distance was applied. The standoff distance was calculated as 150.52 m.   

The UNDEX parameters with the distances given were calculated and tabulated in 

Table 8.  The bulk cavitation zone for Sea TENTACLE model was also calculated by 

using the same MATLAB program with the computed UNDEX parameters and the shot 

geometry. The largest depth in which the bulk cavitation occurs was determined to be 9 

m for this shot. The bulk cavitation region is illustrated in Figure 29. 
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Figure 27.   Sea TENTACLE Model SHOT-2 Geometry (Transverse View) 

 
Figure 28.   Sea TENTACLE Model SHOT-2 Geometry (Longitudinal View) 
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Table 8.   UNDEX Parameters for Sea TENTACLE Model SHOT-2 Simulations 
 

Pmax 498.94 psi 

θ 2.063 msec 

T 0.44 sec 
 
 
 
 

 
Figure 29.   Bulk Cavitation Zone for SHOT-2 

 

D. RAYLEIGH DAMPING COEFFICIENTS 
Velocity-dependent damping is very difficult to visualize for most real structural 

systems, such as sea vessels. Only a small number of structures have a finite number of 

damping elements where real viscous dynamic properties can be measured. In most cases, 

modal damping ratios are utilized in order to determine the approximate nonlinear 

frictional energy dissipation. 

 Most of the inherent damping within a fabricated built-up structure occurs at the 

mechanical joints due to frictional energy dissipation during the vibration of the structure. 

When the contact force in bolted connection is reduced, the system vibration amplitudes 

reduce by increasing joint damping capacity. Nevertheless, the great majority of joints in 

naval ship structure systems are welded rather than mechanically connected, thus 

reducing the energy dissipation through the welds. The naval ship systems also have 

several energy dissipation sources such as long cable trays, hangers, snubbers and the 

surrounding fluid coupled with the hull [Ref. 23].  

Another form of damping, which is often used in the simulation of the dynamic 

response of a structure, is proportional to the stiffness and mass distribution of the 

structure. This damping is called Rayleigh damping. A damping matrix based on the 
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physical properties of the structure is avoided by using Rayleigh damping. The  

damping matrix,[ ]C  is defined in Rayleigh damping as  

 
 [ ] [ ] [ ]C M Kα β= +  (4.1) 
 

in the general expression for the equation of motion. 

 
 { } { } { } { }[ ] [ ] [ ]M x C x K x F+ + =&& &  (4.2) 
 

The damping coefficients α  and β  are pre-defined constants. The orthogonal 

transformation of the damping matrix reduces the matrix [C] to the form  

 
 2[ ] [ ][ ] [2 ] [ ] [ ]T

r r diag r diagC Iφ φ ζ ω α β ω= = +  (4.3) 

Equation (4.3) on simplification reduces to 

 

 1
2i i

i

αζ βω
ω

⎛ ⎞
= +⎜ ⎟

⎝ ⎠
 (4.4) 

It can be observed that the damping ratio is proportional to the natural frequencies 

of the system. When the system has two degrees of freedom, a set of Equation (4.5) is 

solved easily in order to determine the damping coefficients.  

 2
222

2
111

2

2

βω+α=ωζ

βω+α=ωζ
 (4.5) 

 

However, while solving a system having many degrees of freedom such as a ship, 

there will be much more of a challenge to obtain the values of Rayleigh damping 

coefficients, which should be valid for all the n degrees of equation. There is no simple 

solution to determine the coefficients. An iteration solution is possible and this can be 

obtained from the best-fit values of α and β in a particular system. Thus, the damping 

coefficients can be determined by using the measured data and a least squared curve 

fitting method. 

A new set of Rayleigh damping coefficient values was determined by executing a 

comprehensive study at NPS using the measured data taken from the DDG-53 ship shock 
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trials for 2000 msec [Ref. 24]. The ship was divided into 67 area groups with 773 sensors 

for the damping coefficient analysis. Measured modal response over the frequency 

spectrum of interest, 0 to 250 Hz, was recorded for both the vertical and athwartship 

responses. A least squares curve fit, as illustrated in Figure 30, was then applied to each 

area group. Next, weighted averages were given to the area groups based on the number 

of modes used in the least squares curve fitting process required to determine α  and β , 

which are presented in Table 9.  

 

Table 9.   Weighted Mean Values of α  and β  [Ref. 23] 
 

Rayleigh Damping 

Parameters 

Athwartships Direction Vertical Direction 

α  - value 18.4 19.2 

β  - value 2.82E-06 2.09E-06 

 
 

 
Figure 30.   Modal Damping Ratio for Single Area Group, Vertical Direction  [Ref. 

23] 
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As a consequence, the NPS damping coefficient values for DDG-53 were defined 

as 19.2α =  and 2.09E-6β =  in the vertical direction while they were defined as 

18.4α =  and 2.82E-6β =  in the athwartships direction. The great difference in the two 

damping coefficients (α  and β ) implies that the damping within the system is mass-

driven. Regarding the similarity of DDG-53 and DDG-81, the resulting damping 

coefficient values, which were the values in the vertical direction, were used for both 

since the vertical response is much larger in magnitude than the athwartships response 

[Ref. 23 and 24]. Since the application of these damping coefficient values to both ships 

gave very accurate response results close to ship shock trials [Ref. 24], they were used for 

shock simulations of the Sea TENTACLE model as well. The same damping coefficient 

values calculated for the vertical direction were assigned to all the structural solid, shell 

and beam elements in the Sea TENTACLE model in ABAQUS/CAE. 



48 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

THIS PAGE INTENTIONALLY LEFT BLANK 

 



49 

V. DATA COLLECTION AND ANALYSIS 

The ship shock simulations of the Sea TENTACLE model using ABAQUS were 

conducted on a workstation with two 3.06 GHz processors and 2.0 Gbytes of RAM. The 

computational time for each simulation was approximately 3 days.  

A spherical incident shock wave propagates gradually toward the structure. Thus, 

it is apparent that the different portions of the model will exhibit different peak responses 

depending on the standoff distance from the charge and angle of attack. As a result, 

several different nodes throughout the model were selected in order to investigate the 

overall response of the keel, sides, bulkheads and the deck between the two hulls 

subjected to the UNDEX. The most accurate results were expected at the keel since it 

interacted with the incident shock wave first. Thus, 8 nodes were selected (as illustrated 

in Figure 31) in order to determine the response. In order to determine the effect of the 

gap on the response of the model, the nodes at the main deck between the hulls were 

selected as shown in Figure 31.  

 

 

 

 

Figure 31.   The location of the nodes at the keel 
 

Equivalent nodes were selected on each hull to study the effect of the gap between 

the hulls on the response, as shown in Figure 32 and 33. As shown in Figure 34, the 

bulkheads nodes at the centroid were selected in order to compare the kick-off velocity 

with the theoretical value. 
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Node 19568
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Figure 32.   The Location of the Nodes at the Port Side. 

 

 
 

Figure 33.   The Location of the Nodes at the Starboard Side. 
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Figure 34.   The Location of the Nodes at the Bulkheads 
 

The ABAQUS/Explicit model for the shock simulation had a total of 579020 

active degrees of freedom including any Lagrange multiplier variables. The analysis was 

run for 1.5 seconds with an average 2.818 x 10-6 critical time increment and 544724 

solution increments. This time step was computed by ABAQUS/Explicit using element-

by-element stable time increment estimator. This element-by-element estimate is 

determined by using the smallest time increment size due to the dynamic responses in 

each element. 

 

A. SHOCK WAVE PROPAGATION AND BUBBLE FORMATION 
The shock wave produced by the TNT charge propagates from the source point, 

impinging on and passing over the model, producing a temporally and spatially varying 

load on the Sea TENTACLE model. The pressure field is affected by the reflections and 

emissions from the structure as well as the incident field from the source itself. The 

locations of the source and standoff points greatly effect the incident shock wave 

propagation and magnitude. Two output variables were provided for acoustic pressure in 

Node 14137 

Node 17409 
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ABAQUS. One of them is acoustic pressure (POR) and the other is absolute acoustic 

pressure (PABS). POR represents the total dynamic pressure, including additional 

pressure induced by the incident and scattered waves and the dynamic effects of 

cavitation whereas PABS is the sum of acoustic pressure and hydrostatic pressure [Ref. 

22].  The acoustic pressure magnitudes are in Pascal.  

 

1. Shock Wave Propagation and Bubble Formation for SHOT-1 
The shock wave propagation of SHOT-1 is shown in Figure 35. The maximum 

shock wave pressure was calculated as 4.874 x 106 Pa or 706.9 psi which is close to the 

theoretical value of 700 psi. The shock wave pressure profiles and cavitation regions are 

illustrated in Figure 36 and 37 by taking a cross section of the model along the y-axis.  

The spherical shape of the shock wave and the initial shock wave propagation at time 

zero can be seen in Figure 35 and 36, respectively.  

 
Figure 35.   Shock Wave Propagation of SHOT-1 
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t = 0 sec 

 

t = 4 msec 

 

t = 8 msec 

Figure 36.   Shock Wave Pressure Profiles and Cavitation Regions 
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t = 12 msec 

 

t = 20 msec 

 

t = 30 msec 

Figure 37.   Shock Wave Pressure Profiles and Cavitation Regions (continued) 
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The regions having zero pressure represent cavitation regions. As shown in Figure 

36, the incident shock wave forms at time zero, followed by the initial bulk cavitation 

formation. As the shock wave reaches the free surface, a tensile reflected wave is 

generated. This wave decreases the pressure to negative values rapidly. When the 

pressure drops off to zero, it can be stated that the cavitation is occurring and forms 

directly under the structure.  

The time histories of bubble expansion and migration are shown in Figure 38 and 

39 respectively. The bubble oscillation period and the maximum gas bubble radius are 

functions of the types and the weight of the charge and the ambient pressure [Ref. 10]. 

From the simulation in ABAQUS, these values were determined as 0.93 sec and 12 m, 

respectively, which are almost the same as the theoretical values, 0.93 sec and 12.5 m, 

calculated by using Equation 2.4 and 2.6. As shown from Figure 38 and 39, the gas 

bubble rises rapidly due to the buoyancy of the bubble. Since the buoyancy force is large, 

the drag force is also large. After reaching the first maximum, the bubble shrinks due to 

the energy loss and starts migrating faster due to the smaller drag force. The numbers of 

these oscillations depend on the bubble’s loss of energy by radiation or turbulence. 

The gas bubble pressure is also shown in Figure 40. As shown in the figure, the 

initial high pressure in the gas sphere decreases due to the loss of energy and falls below 

the equilibrium that is defined by the atmospheric and hydrostatic pressure. When the 

first bubble pulse forms, the bubble pressure rises again due to the formation of jet 

stream. 
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Figure 38.   Gas Bubble Expansion for SHOT-1 
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Figure 39.   Gas Bubble Migration for SHOT-1 



57 

 
 

GAS BUBBLE PRESSURE

Time (sec)

P
re

s
s
u

re
 (

P
a
)

-2e+008

0

2e+008

4e+008

6e+008

8e+008

1e+009

1.2e+009

1.4e+009

1.6e+009

1.8e+009

0 0.2 0.4 0.6 0.8 1 1.2 1.4 1.6 1.8 2

 
Figure 40.   Gas Bubble Pressure History for SHOT-1 

 

The pressure time history of the fluid node right under the keel is shown in Figure 

41. As seen in Figure 41, the pressure rises quickly to a peak value, and then dips. After 

generation of the tensile reflected wave at the free surface, the pressure drops off to zero 

representing cavitation, as explained before. The second peak occurs due to the reflection 

of the incident shock wave off the structural model and the other peaks occur due to the 

bulk cavitation closure. The cut-off time right under the keel is determined as 3.128 

msec, which corresponds well with the theoretical value 3.086 msec calculated by 

Equation 5.1.   

 2 sinc
xt

C
φ≈  (5.1) 

where x = depth to the point of interest from the surface 

 C = acoustic velocity in the water 

 φ = angular standoff distance from the charge to the point of interest 
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Figure 41.   Resulting Pressure Profile Under the Keel Subjected to SHOT-1 

 
 

2. Shock Wave Propagation and Bubble Formation for SHOT-2 
The shock wave propagation of SHOT-2 is shown in Figure 42. The maximum 

shock wave pressure was determined as 3.471 x 106 Pa or 503.4 psi, which is close to the 

theoretical value, 498.94 psi. The spherical shape of the shock wave and the initial shock 

wave propagation at time zero can be seen in this figure.  
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Figure 42.   Shock Wave Propagation of SHOT-2 

 
 

The time histories of bubble expansion and migration are shown in Figure 44 and 

45, respectively, while the time history of the gas bubble pressure is shown in Figure 43. 

From the simulation in ABAQUS, these values were determined as 0.431 sec and 8.825 

m, respectively, which are close to the theoretical values, 0.44 sec and 9.27 m, calculated 

by using Equation 2.4 and 2.6. The second bubble pulse occurs at 0.8 sec and the bubble 

continues to migrate, losing more energy.  The cycle repeats until the total bubble energy 

is emitted. 
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Figure 43.   Gas Bubble Pressure History for SHOT-2 
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Figure 44.   Gas Bubble Expansion for SHOT-2 
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Figure 45.   Gas Bubble Migration for SHOT-2 

 
 

The pressure time history of the fluid node right under the keel is shown in Figure 

46. As seen in Figure 46, the pressure rises quickly to a peak value and then dips. The 

other peaks occur due to the reflection off of the structure and drops off to zero 

representing the cavitation or underpressure phase. The cut-off time right under the keel 

is determined as 7.005 msec whereas the theoretical value is 6.2072 msec calculated by 

Equation 5.1.   
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Figure 46.   Resulting Pressure Profile Under the Keel Subjected to SHOT-2 

 
 
 
B. VERTICAL VELOCITY RESPONSE 

During an UNDEX event, the primary structural response is in the vertical 

direction. The incident shock wave impinges on the structure with extremely high 

pressure and forces the model to rapidly move upward with respect to the fluid.  In Figure 

47, the dominance of the velocity in the vertical direction, shown in red, is illustrated by 

the selected port keel node which was subjected to SHOT-1. The response data for this 

node is shown in Table 10.  The trend in respond of this node was typical of all selected 

nodes and therefore, the vertical velocity time histories were used primarily for the 

comparisons discussed in this thesis. 

The average vertical kick-off velocity of the model was calculated theoretically 

for the center of gravity of the submerged part of the hull.  The estimated values for both 

shots are tabulated in Table 11. 
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Figure 47.   Velocity History of Node 17198 in XYZ-Directions  

 
 

Table 10.   Peak Velocity Values of Node 17198 in XYZ-Directions 
 

 PEAK VELOCITY (m/sec) 

Vertical Direction  3.26859 

Athwarthships Direction 1.56181 

Longitudinal Direction 0.92079 

 
 

Table 11.   Calculated Average Vertical Kick-Off Velocity Values 
 

 SHOT-1 SHOT-2 

Calculated Average Vertical Kick-Off Velocity (m/sec) 1.51 1.39 
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1. Vertical Velocity Response of the Model Subjected to SHOT-1 

The response of the node at the center of the amidships bulkhead is shown in 

Figure 48 in order to compare the kick-off velocity with the calculated one.  As shown 

from Figure 48, the initial velocity of Node 17409 is 2.00147 m/sec with corresponding 

time 7.087 msec, which is closer to the theoretical kickoff velocity 1.51 m/sec 
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Figure 48.   Vertical Velocity History of Node 17409 

 

The responses of the nodes at the port keel up to 1.5 sec are shown in Figure 49. 

The vertical velocity time history of 0.2 sec is shown in Figure 50 in order to accurately 

capture the response of the nodes having different radial standoff distance at the early 

time. The peak vertical velocity values are tabulated in Table 12. 

 



65 

VERTICAL VELOCITY
NODES  AT KEEL

Node 17833 Node 16867 Node 17198

Time (sec)

V
e
rt

ic
a
l 

V
e
lo

c
it

y
 (

m
/s

e
c
)

-2

-1

0

1

2

3

4

0 0.2 0.4 0.6 0.8 1 1.2 1.4 1.6

 
Figure 49.   Vertical Velocity History of Port Keel Nodes 
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Figure 50.   Trimmed Vertical Velocity History of Port Keel Nodes  
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Table 12.   Peak Vertical Velocity Values for Port Keel Nodes 

 
 Peak Velocity (m/sec) Time (msec) 
Node 17198 3.26859 0.22825           
Node 16867 3.55323     3.26838  
Node 17833 3.86921     3.22969 
 

The node at amidships, Node 17198 reaches its maximum vertical velocity before 

the other two nodes since it is closer to the charge. The other nodes at the bow and stern 

have approximately the same standoff distance, so they exhibit very similar behavior and 

reach their peak values almost at the same time.  

As shown from Figure 51, Node 17198 exhibits high frequency oscillation 

whereas the other nodes exhibit low frequency oscillation, as expected. Since the incident 

shock wave pressure gradually increases, it should be expected that the nodes closer to 

the charge will exhibit high frequency oscillation and take a shorter time to be damped. 

Nodes 16867 and 17833, having a greater radial standoff distance than Node 17198 show 

signs of being slightly over damped. 

The responses of the nodes at the starboard keel are shown in Figure 51 and the 

peak vertical velocity values are tabulated in Table 13. As shown from Figure 51, the 

nodes at the starboard keel respond with a shift in the time and exhibit lower vertical 

velocity compared to the port keel nodes since the charge is located off the port side. 

Similarly with the responses of port keel nodes, the node at amidships, Node 13926 

reaches its maximum vertical velocity before the other two nodes since the radial standoff 

distance is smaller than that of the other nodes; Node 19568 and 15276 exhibit very 

similar behavior and reach their peak values almost at the same time due to the fact that 

they have approximately same standoff distance. 
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Figure 51.   Vertical Velocity History of Starboard Keel Nodes 

 
 
 

Table 13.   Peak Vertical Velocity Values of Starboard Keel Nodes 
 Peak Velocity (m/sec) Time (msec) 
Node 13926 2.35073 14.893   
Node 19568 1.53037     19.864   
Node 15276 1.72117     20.075 
 

The responses of the nodes at the port side are shown in Figure 52 in order to 

compare the response of the nodes having the same horizontal standoff distance but 

different vertical standoff distance. The peak vertical velocity values are tabulated in 

Table 14. 
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Figure 52.   Vertical Velocity History of Port Side Nodes 

 
 

Table 14.   Peak Vertical Velocity Values of Port Side Nodes 
 
 Peak Velocity (m/sec) Time (msec) 
Node at Hull (19019) 0.81549   5.4448  
Node at Main Deck (10167) 0.724138   7.2190         
Node at Deck 01 (3917) 0.943624 7.3323                

 

Node 19019 reaches its maximum vertical velocity first since it is closer to the 

charge than the other nodes. The nodes located higher in the structure make the 

prediction of the response more dependent on the structural model and structural 

damping. Thus, the mass and stiffness distribution must be considered.  

As shown from Figure 52, the node closest to the charge exhibits higher 

frequency oscillations whereas the other nodes exhibit lower frequency oscillations. 

When the shock wave energy propagates upward to the main deck, higher frequency 
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motion of the model is attenuated by structural damping of the ship and lower frequency 

oscillations become dominant. Since the nodes are not too far away from each other, the 

oscillation difference is not so apparent. Thus they exhibit very similar behavior. 

As far as the differences in the vertical velocities of nodes are concerned, it can be 

observed that Node 3917, which is located at deck 01, has the greatest vertical velocity 

among the other compared nodes due to the fact that the deck 01 is less stiff and lighter in 

weight than the main deck and the hull. 

The responses of the nodes at the starboard side are shown in Figure 53 in order to 

compare the responses with the responses of the equivalent port side nodes, and the peak 

vertical velocity values are tabulated in Table 15. 
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Figure 53.   Vertical Velocity History of Starboard Side Nodes  

 

Table 15.   Peak Vertical Velocity Values for Starboard Side Nodes 
 
 Peak Velocity (m/sec) Time (msec) 
Node at Hull (14005) 1.0315 12.1482          
Node at Main Deck (9455) 1.04047   13.5689          
Node at Deck 01 (1426) 1.16235   15.1471          
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Node 14005 reaches its maximum vertical velocity first since it is closer to the 

charge than the other nodes, and exhibits higher frequency oscillations whereas the other 

nodes exhibit a little lower frequency oscillation, as expected. 

The starboard side nodes exhibit greater vertical velocities compared to those of 

the equivalent port side nodes due to the interaction with the deck between the hulls, but 

need more time to reach the peak values and damp due to the greater standoff distance.  

The response of the node at the main deck between the hulls is shown in Figure 

54 in order to analyze the effect of the gap between the hulls on the response.  
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Figure 54.   Vertical Velocity History of Node 9851 

Node 9851 of the main deck is located at the intersection of the centerline and the 

midship line, which does not interact with the fluid mesh but with the air gap. This node 

is approximately aligned at the same horizontal line as the standoff point. The response 

shows different behavior from the other responses. The node exhibits several oscillations 

with low frequency and settles down very slowly compared to other nodes. The incident 

shock wave propagates gradually until it reaches the free surface. At the free surface, the 
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shock wave pressure drops to zero and atmospheric pressure becomes dominant. 

Therefore, it can be stated that there is no vertical pressure or impact, generated by the 

incident shock wave, occurring on the main deck at the gap. Since the node is not 

connected to any other node at one face, the response just depends on the laterally and 

longitudinally connected structural nodes, so Node 9851 responds at a later time and 

generates several low frequency oscillations with a lower peak vertical velocity, 0.8796 

m/sec. 

The responses of the nodes at the fore of the model are shown in Figure 55 in 

order to compare the response of the nodes coupled with the fluid mesh and uncoupled 

with the fluid mesh. The peak vertical velocity values are tabulated in Table 16. 
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Figure 55.   Vertical Velocity History of the Fore Nodes  

 
Table 16.   Peak Vertical Velocity Values for the Fore Nodes 

 Peak Velocity (m/sec) Time (msec) 
Node at Port Hull (6811) 1.8142     15.6947 
Node at Main Deck (6571) 0.9633   23.6415        
Node at Starboard Hull 
(6415) 

1.45478   25.7870           
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 As shown from Figure 55, the node at port hull reaches its maximum vertical 

velocity before the other two nodes and shows more oscillations than the other nodes due 

to the fact that it is the closest node to the charge. The responses of the nodes exhibit 

similar behavior with a small time shift, as expected. The nodes damp almost at the same 

time because they are close to each other.  

 Since Node 6571 is not coupled with the fluid mesh and there is no occurrence of 

vertical incident shock impact on the node, it has the smallest peak velocity among the 

compared nodes.  

2. Vertical Velocity Response of the Model Subjected to SHOT-2 
The response of the node at the center of the midships bulkhead of the port hull is 

shown in Figure 56 in order to compare the kick-off velocity with the calculated one. The 

initial velocity of Node 17409 is 1.315 m/sec, with corresponding time 1.223 msec, 

which almost corresponds to the theoretical kickoff velocity 1.392 m/sec. 
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Figure 56.   Vertical Velocity History of Node 17409 

 

The responses of the nodes at the fore of the model are shown in Figure 57 in 

order to compare the response of the nodes coupled with fluid mesh and uncoupled with 

the fluid mesh. The peak vertical velocity values are tabulated in Table 17. As shown 

from the figure, the nodes exhibit a distinctive rise in vertical velocity at the time of the 
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bubble pulse formations, such as time 0.43, 0.8 and 1.18 sec, due to the rise in bubble 

pressure. In order to analyze the responses accurately, the trimmed vertical velocity time 

histories are generated as in Figure 58.  
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Figure 57.   Vertical Velocity History of Fore Nodes 

VERTICAL VELOCITY

Node at Port Hull (Node 6811)
Node at Main Deck (Node 6571)
Node at Starboard Hull (Node 6415)

Time (sec)

V
e
rt

ic
a
l 
V

e
lo

c
it

y
 (

m
/s

e
c
)

-2

-1

0

1

2

3

0 0.1 0.2 0.3 0.4

 
Figure 58.   Trimmed Vertical Velocity History of Fore Nodes 
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Table 17.   Peak Velocity Values of Fore Nodes 

 
 Peak Velocity (m/sec) Time (msec) 
Node at Port Hull (6811) 2.88399     14.8310 
Node at Main Deck (6571) 2.00497     21.8718 
Node at Starboard Hull 
(6415) 

2.39654     15.3685 

 

As shown from Figure 58, the node at port hull reaches its maximum vertical 

velocity before the other two nodes and shows more oscillation than the other nodes due 

to the fact that it is the closest node to the charge. The nodes damp almost at the same 

time because they are close to each other.  

The behavior of the nodes subjected to SHOT-2 is similar to the behavior 

subjected to SHOT-1. The difference is that they have higher peak vertical velocities at 

the fore of the model and need more time to damp when subjected to SHOT-2.  Node 

6571 exhibits the smallest peak velocity among the compared nodes due to the same 

reason explained in Section 1.  

The responses of the nodes at the port keel are shown in Figure 59 in order to 

compare the response of the nodes having different radial standoff distance. The peak 

vertical velocity values are tabulated in Table 18. 

As shown from Figure 59, the node at midships, Node 17198 reaches its 

maximum vertical velocity before the other two nodes since it is closer to the charge. The 

other nodes at the bow and stern have approximately the same standoff distance, so they 

exhibit very similar behavior and reach their peak values almost at the same time. Node 

17198 exhibits high frequency oscillation whereas the other nodes exhibit low frequency 

oscillation, as expected. 
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Figure 59.   Vertical Velocity History of Port Keel Nodes 

 
 

Table 18.   Peak Vertical Velocity Values of Port Keel Nodes 
 
 Peak Velocity (m/sec) Time (msec) 
Node 17198 1.78315     4.85236  
Node 17833 3.74692     1.07925 
Node 16867 3.85908     1.29341 

 

The responses of the nodes at the port side are shown in Figure 60 and the peak 

vertical velocity values are tabulated in Table 19. 
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Figure 60.   Vertical Velocity History of Port Side Nodes 

 
 

Table 19.   Peak Vertical Velocity Values of Port Side Nodes 
 
 Peak Velocity (m/sec) Time (msec) 
Node 19019 0.5709 1.36949       
Node 10167 0.5415 3.22078       
Node 3917 0.6037 5.45572       

 

Node 19019 reaches its maximum vertical velocity first since it is closer to the 

charge than the other nodes and exhibits higher frequency oscillations. The other nodes at 

the bow and stern have very similar behavior and reach their peak values almost at the 

same time, as expected. As shown in Table 19 Node 3917, which is located at deck 01, 

has the greatest vertical velocity among the other compared nodes due to the fact that 

Node 3917 has more structural support from the bottom and the upper deck is less stiff 

and lighter in weight than the other decks.  
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The port side nodes have lower vertical velocity and less time to reach the peak 

velocity compared to the responses subjected to SHOT-1 due to greater radial standoff 

distance. 

The responses of the nodes at the starboard side are shown in Figure 61 and the 

peak vertical velocity values are tabulated in Table 20. 
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Figure 61.   Vertical Velocity History of Starboard Nodes 

 
 

Table 20.   Peak Vertical Velocity Values of Starboard Nodes 
 
 Peak Velocity (m/sec) Time (msec) 
Node 14005 1.07169   1.75554         
Node 9455 0.92907 3.83511       
Node 1426 0.94686 5.73069       

Node 14005 reaches its maximum vertical velocity first since it is closer to the 

charge than the other nodes, and exhibits higher frequency oscillations whereas the other 

nodes exhibit a little lower frequency oscillation, as expected. 

The starboard side nodes have similar vertical velocity but need more time to 

reach the peak velocity compared to the responses of the nodes subjected to SHOT-1. 
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C. ATHWARTSHIPS AND LONDITUDINAL RESPONSE 

Even though the major excitement is in the vertical direction, the athwartships and 

longitudinal velocity response of several nodes is also included in order to implement the 

UNDEX analysis of the Sea TENTACLE model. In this section, only SHOT-1 will be 

considered.  

The athwartships velocity time histories of Node 17409, which is located at the 

midships bulkhead of the port hull are shown in Figure 62 and 63. In Figure 63, the 

velocity time history is trimmed to 0.6 sec in order to accurately capture the response of 

the node. The peak athwartships velocity of Node 17409 is determined to be 0.9218 

m/sec corresponding to time 13.8819 msec.  
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Figure 62.   Athwartships Velocity History of Node 17409 
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Figure 63.   Trimmed Athwartships Velocity History of Node 17409 

 

As shown from Figure 63, the node first gets the negative values that represent the 

values in the same direction of the shock wave based on the coordinate system of the 

model, as expected. Then, it reaches the equilibrium point and exhibits positive velocity 

values that represent the values in the opposite direction of the shock wave.  

Node 17409 exhibits very high frequency oscillations at an early time. After time 

0.14 msec, the node tends to fluctuate with a lower frequency and damp. The peak 

athwartships velocity value is 54% lower than that of the peak vertical velocity. 

The longitudinal response of Node 17409 is shown in Figure 64. The peak 

longitudinal velocity of Node 17409 is 0.4133 m/sec corresponding to time 15.9281 

msec.  
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Figure 64.   Longitudinal Velocity History of Node 17409 

 

As shown from Figure 64, the node first gets the negative values that represent the 

values in the fore direction of the model depending on the coordinate system of the 

model. Then, it reaches the equilibrium point and exhibits positive velocity values that 

represent the values in the aft direction of the model.  

According to the responses of Node 17409 in all directions, it can be stated that 

they dampen out almost at the same time and exhibit a similar number of oscillations. 

The peak longitudinal velocity value is 79% lower than that of the peak vertical velocity. 

The athwartships responses of the nodes at the port keel are shown in Figure 65 

and the peak athwartships velocity values are tabulated in Table 21.  
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Figure 65.   Athwartships Velocity History of Keel Nodes 

 
Table 21.   Peak Athwartships Velocity Value of Keel Nodes 

 
 Peak Velocity (m/sec) Time (msec) 
Node 17198 1.56181   15.0485          
Node 16867 1.06659   34.6506          
Node 17833 1.26544  21.1943          

Since the node amidships, Node 17198 is closer to the charge, it reaches its 

maximum vertical velocity before the other two nodes and exhibits high frequency 

oscillation whereas the other nodes exhibit low frequency oscillation, which is the same 

as the responses in the vertical direction.   

Nodes 16867 and 17833 have approximately the same standoff distance, so they 

exhibit very similar behavior and dampen out almost at the same time. According to 

Table 21, the peak athwartships velocity values are approximately 52% lower than those 

of the peak vertical velocity. The longitudinal responses of the nodes at the port keel are 

shown in Figure 66 and the peak longitudinal velocity values are tabulated in Table 22. 
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Figure 66.   Longitudinal Velocity History of Keel Nodes 

 
Table 22.   Peak Longitudinal Velocity Values of Keel Nodes 

 
 Peak Velocity (m/sec) Time (msec) 
Node 17198 -0.92106     10.7091 
Node 16867 -0.85754 14.1221 
Node 17833 1.33261  13.4016 

The behavior of the nodes in the longitudinal direction is also similar to the 

behavior in the vertical and athwartships direction. Node 17198 exhibits the higher 

frequency oscillation and reaches the peak values first whereas the other nodes exhibit 

lower frequency oscillation due to the standoff distance. According to Table 22, the peak 

longitudinal velocity values are approximately 72% lower than those of the peak vertical 

velocity.   

The athwartships response of Node 9851 which is at the main deck between the 

hulls is shown in Figure 67 and the peak athwartships velocity of Node 9851 was 

determined to be 0.3838 m/sec corresponding to time 26.3771 msec.  
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Figure 67.   Athwartships Velocity History of Node 9851 

 

Since Node 9851 does not interact with the fluid mesh directly, it exhibits several 

oscillations with lower frequency and lower velocity, and settles down very slowly 

compared to other nodes. As shown from Figure 67, the node fluctuates with very small 

velocity at an early time. After time 25 msec, the node achieves higher velocity and starts 

to oscillate. This is due to the fact that the response of Node 9851 depends on the 

connected structural nodes. Therefore, it exhibits the peak values at a later time. 

It can be stated that the behavior in this direction is very similar to the behavior in 

the vertical direction, but the peak athwartships velocity of Node 9851 was determined to 

be 0.3838 m/sec corresponding to time 26.3771 msec, which is 56% lower than the peak 

vertical velocity. The longitudinal response of Node 9851 is shown in Figure 68.  
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Figure 68.   Longitudinal Velocity History of Node 9851 

 

As shown from Figure 68, Node 9851 damps in the longitudinal direction earlier 

than it does in the other directions and the peak longitudinal velocity value, 0.2722 m/sec, 

is 69% lower than that of the peak vertical velocity. 

According to the velocity history of all 14 nodes, the longitudinal response is 60% 

and the athwartships response is 48% lower than the vertical response. As a consequence, 

the vertical response is dominant to the responses in other directions as it was also 

determined to be the dominant response in previous monohull ship simulations. Because 

of the determined fact, the vertical response was of considerable interest. Even though the 

vertical response is dominant, the longitudinal and athwartships responses greatly depend 

on the geometry of attack.   
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D. SHOCK SPECTRA ANALYSIS  

The shock spectrum is the peak absolute response of undamped single degree-of-

freedom produced by a shock loading with respect to the natural frequency. It is assumed 

that the shock pulse is applied as a common base input. The peak value of the response is 

selected from determined response time history. Then, the peak response values over a 

range of frequencies are determined by varying the natural frequency and shock spectra is 

formed. [Ref. 10] A shock spectrum is simply a graph of maximum response versus 

frequency.  Since the vertical velocity was dominant as explained in previous sections, 

then the vertical time history of the nodes was used as the input in this thesis. 

Evaluating the data presented in the shock spectra plot is essential for 

understanding the physical behavior of an UNDEX event. Since the shock spectra reduce 

the complexity to a simple measure, it is easier to compare the response in the frequency 

domain than in the time domain, especially at lower natural frequencies of the structure. 

There is also no need to consider a wide range of velocity values since the shock spectra 

are generated in terms of velocity and thus, just considering the frequency range will be 

enough. Consequently, the shock spectrum is a useful tool for easily estimating the 

damage potential of a shock pulse.  

In the shock spectra plot, both axes are in logarithmic scale. The y-axis is called 

“Pseudo Velocity” instead of vertical velocity because all quantities, determined by using 

a single degree of freedom system, are exact only if the peak responses occur after the 

shock pulse has passed.  The diagonal and off-diagonal axes indicate the absolute relative 

displacement and acceleration. In order to read the absolute relative acceleration and 

displacement response at a desired frequency, the point at the intersection of the curve 

and frequency should follow the diagonal axis and off–diagonal axis, respectively. The 

values of the relative displacement and acceleration are shown in logarithmic scale at the 

top and right sides of the plot. 

UERD Tools, which is capable of generating shock spectra practically, was used 

in order to create the shock spectra plots of the Sea TENTACLE model. 
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1. Shock Spectra Plots of SHOT-1 

Shock spectra of port side nodes subjected to SHOT-1, shown in Figure 69, were 

generated by averaging the shock spectra of all 15 nodes at the port side of the model. 

Similarly, shock spectra of starboard side and main deck between the hulls were 

generated by averaging the response of all 13 and 5 nodes, respectively. The plots are 

shown in Figure 70 and 71. Maximum pseudo velocity values of the model and 

corresponding frequencies are tabulated in Table 23. 

According to the figures, the frequency range 1-5 Hz can be defined as the 

fundamental frequency that corresponds to the hull response. The frequency range 

between 5-50 Hz is essential for mechanical equipment such as engines, pumps, and 

auxiliary mechanical systems whereas the frequency higher than 100 Hz is essential for 

electrical equipments such as radar, sonar and control systems. 

Shock spectra of all three decks exhibit gradually rise in amplitude without 

oscillations up to 5 Hz which is defined as the fundamental frequency. As the frequency 

increases, the shock spectra plots of starboard and port sides display rise in amplitude 

with some oscillations while the shock spectra of the deck between the hulls exhibit 

oscillations between 1 and 2 m/sec amplitude. Above 40 Hz, the responses of the 

starboard and port sides tend to fluctuate much more and the peak pseudo velocity values 

occur, which was also encountered at the previous simulation of the monohull ships. As 

far as the shock spectra of the deck between the hulls are concerned, the peak values 

occur between 10 and 40 Hz. Generally, it can be stated that the peak values occur at the 

intermediate level of frequency for the deck between the hulls whereas they occur at the 

high level of frequency for the port and starboard sides.  
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Figure 69.   Averaged Shock Spectra of Port Side (SHOT-1) 
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Figure 70.   Averaged Shock Spectra of Starboard Side (SHOT-1) 
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Figure 71.   Averaged Shock Spectra of Deck Between the Hulls (SHOT-1) 

 
Table 23.   Maximum Pseudo Velocity Values of Model Subjected to SHOT-1 

 MAXIMUM PSEUDO 

VELOCITY (m/sec) 

CORRESPONDING 

FREQUENCY (Hz) 

Port Side 4.326 48 

Starboard Side 3.541 45 

Deck between the Hulls  2.045 18 

 

2. Shock Spectra Plots of SHOT-2 

Shock spectra of port side nodes subjected to SHOT-2, shown in Figure 72, were 

generated by averaging the shock spectra of all 15 nodes at the port side of the model. 

Similarly, shock spectra of starboard side and main deck between the hulls were 

generated by averaging the response of all 13 and 5 nodes, respectively. The plots are 

shown in Figure 73 and 74. Maximum pseudo velocity values of the model and 

corresponding frequencies are tabulated in Table 24. 
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Figure 72.   Averaged Shock Spectra of Port Side (SHOT-2) 
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Figure 73.   Averaged Shock Spectra of Starboard Side (SHOT-2) 
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Figure 74.   Averaged Shock Spectra of Deck Between the Hulls (SHOT-2) 

 
Table 24.   Maximum Pseudo Velocity Values of Model Subjected to SHOT-2 

 

 MAXIMUM PSEUDO 

VELOCITY (m/sec) 

CORRESPONDING 

FREQUENCY (Hz) 

Port Side 6.748 48 

Starboard Side 6.405 48 

Deck between the Hulls  4.652 56 

 

According to the shock spectra plots of the model subjected to SHOT-2, the peak 

values occur between 40 Hz and 70 Hz with higher frequency oscillations compared to 

SHOT-1 results, as expected. Above 70 Hz, the shock spectra plots display a downward 

trend, which was also encountered during previous simulations of the monohull ships. 

Generally, it can be stated that the peak values occur at the high level of frequency for the 

deck between the hulls, the port and starboard sides. 



91 

VI. CONCLUSION AND RECOMMENDATIONS 

This thesis investigated the computer modeling and simulation of a catamaran-

hull ship subjected to an underwater explosion. The shock simulation of Sea 

TENTACLE, the 2005 TSSE interdisciplinary team design, was executed using 

ABAQUS finite element solver. Of particular concern in this thesis was the effect of the 

gap between the hulls, which was not coupled with fluid mesh, on the response of the 

model. Two shots were generated and presented in order to analyze the ship’s response to 

underwater explosions with different attack geometries. Time histories and shock spectra 

plots of selected nodes were also presented. 

From this study, it was determined that the kick-off velocities and cut-off times 

obtained from the simulation in ABAQUS correspond well with the calculated values. 

The simulation also introduced a smooth gas bubble time history that matches with the 

theoretical Geers-Hunter bubble model.  

As far as the response of the deck between the hulls is concerned, it was observed 

that it exhibited several irregular low frequency oscillations and settled down very 

slowly. Since the incident shock wave did not interact with the deck directly, the response 

of the deck was dependent on the responses of the connected port and starboard sides. 

For both shots the port hull, which was closer to the charge, behaved like the 

well-studied monohull ship. The starboard hull can be defined as a secondary hull which 

received an additional impact from the deck in additional to the direct shock from the 

wetted surface. It showed similar behavior to port hull but with a distinct time shift. The 

similar response of both hulls was evident in the time history and shock spectra plots. 

Additionally, this study examined the role of the responses in different directions. 

According to the time history of selected nodes, it was determined that the longitudinal 

response was 60% and the athwartships response was 48% lower than the vertical 

response. Thus, it can be stated that the vertical response is also dominant in catamaran 

hull ships’ response. 
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Recommendations for areas of additional study: 

1. In order to increase accuracy of the response, modeling the surrounding fluid 

with a more homogenous hexahedral element mesh is suggested in place of 

the tetrahedral fluid mesh used herein. In order to achieve this, the fluid 

geometry should be carefully partitioned before meshing. 

2. To fully evaluate the results of the simulation, the simulated responses should 

be compared with the results from the shock trial of the actual ship. Since the 

Sea TENTACLE model is not an actual ship, the comparison with the results 

of the shock trial of a similarly sized catamaran hull ship is recommended.  

3. This thesis investigated the far field UNDEX, so the bottom reflection was not 

taken into consideration. In shallow water reflection of the incident shock 

wave off the sea bottom cannot be neglected. Therefore, it is recommended 

that the shock simulation of the Sea TENTACLE model in shallow waters 

should be conducted. 
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APPENDIX A.  MATLAB PROGRAM CODE FOR BULK 
CAVITATION ZONE 

The following MATLAB code was written using MATLAB® 6.5 Release 13.  

This code calculates the bulk cavitation zone boundaries and plots a visualization of the 

bulk cavitation region depending on the user’s input. For different aspects of comparison, 

the user can select the analysis type first, as shown in Figure 75. According to the 

analysis type, the user has several options to select the charge type, the charge weight, the 

charge depth, and the vertical and horizontal distances of interest.   

This program was used to calculate the bulk cavitation zone for the Sea 

TENTACLE model. 

 
Figure 75.   MATLAB Program Interfaces 
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% cav_zone.m by Hakan UCAR Ltjg., Turkish Navy 
% Determining the bulk cavitation 
% VARIABLES: W        : Charge weight 
%            D        : Charge depth 
%            r1       : Radial standoff distance 
%            r2       : Image radial standoff distance 
%            P1       : Incident pressure at cut-off 
%            P2       : Image pressure at cut-off 
%            Pa       : Atmospheric pressure 
%            Pd       : Hydrostatic pressure 
%            theta    : Decay rate constant 
             
clc; clear all; 
m=menu(' SELECT THE ANALYSIS TYPE ','ANALYSIS OF EXPLOSIVE TYPE EFFECT 
WITH SAME WEIGHT AND DEPTH','ANALYSIS OF CHARGE WEIGHT EFFECT 
','ANALYSIS OF CHARGE DEPTH EFFECT') 
if m == 1; 
    n1=menu(' SELECT THE FIRST EXPLOSIVE TYPE ','HBX-
1','TNT','PETN','NUKE'); 
    n2=menu(' SELECT THE SECOND EXPLOSIVE TYPE ','HBX-
1','TNT','PETN','NUKE'); 
    
    if n1 == 1 
       K1 = 22347.6;   % Pmax coefficient 
       A1 = 1.144;     % Pmax coefficient 
       K2 = 0.056;     % Decay constant coefficient 
       A2 = -0.247;    % Decay constant coefficient 
       charge='HBX-1'; 
    end 
    if n1 == 2 
       K1 = 22505; 
       A1 = 1.18; 
       K2 = 0.058; 
       A2 = -0.185; 
       charge='TNT'; 
    end 
    if n1 == 3 
       K1 = 24589; 
       A1 = 1.194; 
       K2 = 0.052; 
       A2 = -0.257; 
       charge='PETN'; 
    end 
    if n1 == 4 
       K1 = 4.38E+06; 
       A1 = 1.18; 
       K2 = 2.274; 
       A2 = -0.22; 
       charge='NUKE'; 
    end 
    data   = { 'Horizontal Distance (ft)',... 
           'Vertical Distance (ft) ',... 
           'Charge Weight (lbs)',... 
           'Charge Depth (ft)'}; 
    input_data = inputdlg(data,'INPUT',1); 
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    H = str2num(char(input_data(1))); 
    V = str2num(char(input_data(2)));  
    W = str2num(char(input_data(3)));  
    D = str2num(char(input_data(4)));  
    
    depth=zeros(V,H); 
    c=5.078; 
    i=0; 
    for y=1:(V+1) 
        for x=1:(H+1) 
            r1=sqrt((D - (y-1))^2 + (x-1)^2); 
            r2=sqrt((D + (y-1))^2 + (x-1)^2); 
            theta = K2*(W^(1/3))*(((W^(1/3))/r1)^(A2)); 
            P1=(K1*(W^(1/3)/r1)^(A1))*(exp(-(r2 -r1)/(c*theta))); 
            Pa=14.7; 
            Pd=0.4443680556*(y-1); 
            P2=-(K1*((W^(1/3)/r2)^(A1))); 
            % Upper boundary 
            F = P1 + Pa + Pd + P2;          
            g1=-P1/(c*theta)*(1 + (((r2 - 2*D*((D+(y-1))/r2))/r1) 
*((A2*r2/r1)-A2-1))); 
            g2=-(A1*P1/r1^2)*(r2-2*D*((D+y-1)/r2)); 
            g3=(0.4443680556*((D+y-1)/r2)); 
            g4=((A1/r2)*(P1+Pa+Pd)); 
            % Lower boundary 
            G = g1+g2+g3+g4; 
             
            if F < 0 & G < 0; 
                depth(y,x)=1; 
            end 
        end 
    end     
     figure(1) 
     subplot(2,1,1) 
     imagesc(depth) 
     title(['CAVITATION REGIONS FOR ',num2str(W),' lb ',charge,' AT 
',num2str(D),' ft ']) 
     ylabel('Depth (ft)') 
     axis equal 
     axis([0 H 0 V]) 
     hold on; 
      
    if n2 == 1 
       K1 = 22347.6; 
       A1 = 1.144; 
       K2 = 0.056; 
       A2 = -0.247; 
       charge='HBX-1'; 
    end 
    if n2 == 2 
       K1 = 22505; 
       A1 = 1.18; 
       K2 = 0.058; 
       A2 = -0.185; 
       charge='TNT'; 
    end 
    if n2 == 3 
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       K1 = 24589; 
       A1 = 1.194; 
       K2 = 0.052; 
       A2 = -0.257; 
       charge='PETN'; 
    end 
    if n2 == 4 
       K1 = 4380000; 
       A1 = 1.18; 
       K2 = 2.274; 
       A2 = -0.22; 
       charge='NUKE'; 
    end 
   
    depth2=zeros(V,H); 
    c=5.078; 
    for y=1:(V+1) 
        for x=1:(H+1) 
            r1=sqrt((D - (y-1))^2 + (x-1)^2); 
            r2=sqrt((D + (y-1))^2 + (x-1)^2); 
            theta = K2*(W^(1/3))*(((W^(1/3))/r1)^(A2)); 
            P1=(K1*(W^(1/3)/r1)^(A1))*(exp(-(r2 -r1)/(c*theta))); 
            Pa=14.7; 
            Pd=0.4443680556*(y-1); 
            P2=-(K1*((W^(1/3)/r2)^(A1))); 
            F = P1 + Pa + Pd + P2; 
            g1=-P1/(c*theta)*(1 + (((r2-2*D*((D+(y-1))/r2))/r1)* ((A2* 
r2/r1)-A2-1))); 
            g2=-(A1*P1/r1^2)*(r2-2*D*((D+y-1)/r2)); 
            g3=(0.4443680556*((D+y-1)/r2)); 
            g4=((A1/r2)*(P1+Pa+Pd)); 
            G = g1+g2+g3+g4; 
             
            if F < 0 & G < 0; 
                depth2(y,x)=1; 
            end 
        end 
    end     
 
     figure(1) 
     subplot(2,1,2) 
     imagesc(depth2) 
     title(['CAVITATION REGIONS FOR ',num2str(W),' lb ',charge,' AT 
',num2str(D),' ft ']) 
     xlabel(' RED REGION IS CAVITATION REGION ') 
     ylabel('Depth (ft)') 
     axis equal 
     axis([0 H 0 V]) 
     hold on;    
end 
 
if m == 2; 
n=menu(' SELECT THE EXPLOSIVE TYPE ','HBX-1','TNT','PETN','NUKE'); 
if n == 1 
    K1 = 22347.6; 
    A1 = 1.144; 
    K2 = 0.056; 
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    A2 = -0.247; 
    charge='HBX-1'; 
end 
if n == 2 
    K1 = 22505; 
    A1 = 1.18; 
    K2 = 0.058; 
    A2 = -0.185; 
    charge='TNT'; 
end 
if n == 3 
    K1 = 24589; 
    A1 = 1.194; 
    K2 = 0.052; 
    A2 = -0.257; 
    charge='PETN'; 
end 
if n == 4 
    K1 = 4.38E+06; 
    A1 = 1.18; 
    K2 = 2.274; 
    A2 = -0.22; 
    charge='NUKE'; 
end 
data   = { 'Horizontal Distance (ft)',... 
           'Vertical Distance (ft) ',... 
           'Charge Weight-I (lbs)',... 
           'Charge Weight-II (lbs)',... 
           'Charge Weight-III (lbs)',... 
           'Charge Depth (ft)'}; 
input_data = inputdlg(data,'INPUT',1); 
H = str2num(char(input_data(1))); 
V = str2num(char(input_data(2)));  
W1 = str2num(char(input_data(3)));  
W2 = str2num(char(input_data(4)));  
W3 = str2num(char(input_data(5)));  
D = str2num(char(input_data(6)));  
 
depth=zeros(V,H); 
c=5.078; 
i=0; 
j=0; 
Gamma = 63.989/144; 
     for W=[W1 W2 W3] 
         i=i+1; 
         for y=1:(V+1) 
             for x=1:(H+1) 
                 r1=sqrt((D - (y-1))^2 + (x-1)^2); 
                 r2=sqrt((D + (y-1))^2 + (x-1)^2); 
                 theta = K2*(W^(1/3))*(((W^(1/3))/r1)^(A2)); 
                 P1=(K1*(W^(1/3)/r1)^(A1))*(exp(-(r2 -r1)/(c*theta))); 
                 Pa=14.7; 
                 Pd=0.4443680556*(y-1); 
                 P2=-(K1*((W^(1/3)/r2)^(A1))); 
                 F = P1 + Pa + Pd + P2; 
                 g1=-P1/(c*theta)*(1 + (((r2 - 2*D*((D+(y-1))/r2))/r1) 
*((A2*r2/r1)-A2-1))); 
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                 g2=-(A1*P1/r1^2)*(r2-2*D*((D+y-1)/r2)); 
                 g3=(0.4443680556*((D+y-1)/r2)); 
                 g4=((A1/r2)*(P1+Pa+Pd)); 
                 G = g1+g2+g3+g4; 
                  
                 if F < 0 & G < 0; 
                    depth(y,x)=1; 
                 end 
             end 
         end 
         temp(:,:,i)=depth; 
 end 
     figure(1) 
     subplot(3,1,1) 
     imagesc(temp(:,:,1)) 
     title(['CAVITATION REGIONS FOR ',num2str(W1),' lb ',charge,' AT 
',num2str(D),' ft ']) 
     ylabel('Depth (ft)') 
     axis equal 
     axis([0 H 0 V]) 
      
     subplot(3,1,2) 
     imagesc(temp(:,:,2)) 
     title(['CAVITATION REGIONS FOR ',num2str(W2),' lb ',charge,' AT 
',num2str(D),' ft ']) 
     ylabel('Depth (ft)') 
     axis equal 
     axis([0 H 0 V]) 
      
     subplot(3,1,3) 
     imagesc(temp(:,:,3))  
     title(['CAVITATION REGIONS FOR ',num2str(W3),' lb ',charge,' AT 
',num2str(D),' ft ']) 
     ylabel('Depth (ft)') 
     xlabel(' RED REGION IS CAVITATION REGION ') 
     axis equal 
     axis([0 H 0 V]) 
end 
 
if m == 3; 
    n=menu(' SELECT THE EXPLOSIVE TYPE ','HBX-1','TNT','PETN','NUKE'); 
     
    if n == 1 
       K1 = 22347.6; 
       A1 = 1.144; 
       K2 = 0.056; 
       A2 = -0.247; 
       charge='HBX-1'; 
    end 
    if n == 2 
       K1 = 22505; 
       A1 = 1.18; 
       K2 = 0.058; 
       A2 = -0.185; 
       charge='TNT'; 
    end 
    if n == 3 
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       K1 = 24589; 
       A1 = 1.194; 
       K2 = 0.052; 
       A2 = -0.257; 
       charge='PETN'; 
    end 
    if n == 4 
       K1 = 4.38E+06; 
       A1 = 1.18; 
       K2 = 2.274; 
       A2 = -0.22; 
       charge='NUKE'; 
    end 
    data   = { 'Horizontal Distance (ft)',... 
           'Vertical Distance (ft) ',... 
           'Charge Depth-I (ft)',... 
           'Charge Depth-II (ft)',... 
           'Charge Depth-III (ft)',... 
           'Charge Weight (lbs)'}; 
    input_data = inputdlg(data,'INPUT',1); 
    H = str2num(char(input_data(1))); 
    V = str2num(char(input_data(2)));  
    D1 = str2num(char(input_data(3)));  
    D2 = str2num(char(input_data(4)));  
    D3 = str2num(char(input_data(5)));  
    W = str2num(char(input_data(6)));  
    depth=zeros(V,H); 
    c=5.078; 
    i=0; 
 
    for D=[D1 D2 D3] 
         i=i+1; 
         for y=1:(V+1) 
             for x=1:(H+1) 
                 r1=sqrt((D - (y-1))^2 + (x-1)^2); 
                 r2=sqrt((D + (y-1))^2 + (x-1)^2); 
                 theta = K2*(W^(1/3))*(((W^(1/3))/r1)^(A2)); 
                 P1=(K1*(W^(1/3)/r1)^(A1))*(exp(-(r2 -r1)/(c*theta))); 
                 Pa=14.7; 
                 Pd=0.4443680556*(y-1); 
                 P2=-(K1*((W^(1/3)/r2)^(A1))); 
                 F = P1 + Pa + Pd + P2; 
                 g1=-P1/(c*theta)*(1 + (((r2 - 2*D*((D+(y-1))/r2))/r1) 
*((A2*r2/r1)-A2-1))); 
                 g2=-(A1*P1/r1^2)*(r2-2*D*((D+y-1)/r2)); 
                 g3=(0.4443680556*((D+y-1)/r2)); 
                 g4=((A1/r2)*(P1+Pa+Pd)); 
                 G = g1+g2+g3+g4; 
                  
                 if F < 0 & G < 0; 
                    depth(y,x)=1; 
                 end 
             end 
         end 
         temp(:,:,i)=depth; 
     end 
     figure(1) 
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     subplot(3,1,1) 
     imagesc(temp(:,:,1)) 
     title(['CAVITATION REGIONS FOR ',num2str(W),' lb ',charge,' AT 
',num2str(D1),' ft ']) 
     ylabel('Depth (ft)') 
     axis equal 
     axis([0 H 0 V]) 
      
     subplot(3,1,2) 
     imagesc(temp(:,:,2)) 
     title(['CAVITATION REGIONS FOR ',num2str(W),' lb ',charge,' AT 
',num2str(D2),' ft ']) 
     ylabel('Depth (ft)') 
     axis equal 
     axis([0 H 0 V]) 
      
     subplot(3,1,3) 
     imagesc(temp(:,:,3))  
     title(['CAVITATION REGIONS FOR ',num2str(W),' lb ',charge,' AT 
',num2str(D3),' ft ']) 
     ylabel('Depth (ft)') 
     xlabel(' RED REGION IS CAVITATION REGION ') 
     axis equal 
     axis([0 H 0 V]) 
end 
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APPENDIX B.   STRUCTURAL MODELING OF SEA TENTACLE 
MODEL USING TRUEGRID  

This appendix covers the detailed process for creating the structural finite element 

mesh of the Sea TENTACLE model by using TrueGrid’s part feature BLOCK command 

and PROJECTION method that projects the nodes onto the surface.  

The BLOCK command, which is used in part phase, is the standard way to 

generate parts in TrueGrid. By using the PROJECTION command, TrueGrid 

automatically places the edges of the block along intersections of the surfaces and the 

corners at the intersection of the surfaces. The intent of this appendix is not to serve as a 

tutorial since the familiarity of the code is assumed. Additional information can be found 

in the TrueGrid user manual [Ref. 21]. 

The part generation procedure is described as follows. The important commands 

and menu selections are denoted in bold and in all capital letters for emphasis.  

1. The IGES command is used to import the geometry in the ASCII IGES 
file. The structural geometry that was created in RHINO 3.0 was imported 
as an IGES file (CatHakanWithNewFront2.igs) by using this command. 

2. The ABAQMATS command is used to specify the material model in 
TrueGrid. This command can be used in the TrueGrid code file before 
each element type --such as beam, shell and solid elements-- has been 
created. Two ABAQUS material were defined in the model, one for the 
beam elements and the other for the shell elements. The specifications of 
the elements --such as the density, the modulus of the elasticity and 
Poisson’s ratio-- were entered by using this command.   

3. In the PARTS phase, the BLOCK command is used to create the parts. 
These blocks are the main parts of the structural mesh.  The block part is 
defined by a list of integers (logical mesh) and coordinates (physical 
mesh). Six lists of numbers follow the BLOCK command. The first three 
lists are lists of indices (i, j and k). The first list of integers must start with 
1 or -1.  The integers that follow must be zero or have an absolute value 
greater than the absolute values of the integers that preceded them in that 
list. These numbers tell TrueGrid the number of nodes to be created in the 
first dimension of the computational mesh. A positive integer indicates 
that there will be a partition at that nodal index in the first dimension of 
the computational mesh. These partitions are used to break the part into 
multiple structured blocks. When positive integers are used, solid elements 
are created. A negative integer in the list also produces a partition in the 
mesh with a nodal index corresponding to the absolute value of the 
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integer, with shell elements created along that partition in the 
computational mesh. The second list is the lists of values of physical 
coordinates (x, y, and z coordinate) which indicate the location of the part. 
18 blocks were created with shell elements in the Sea TENTACLE model.  

4. The MATE command is used to assign the material number, which is 
defined by ABAQMATS command, for the whole part or the beam 
elements. The material assignment can be overwritten by other commands 
(MT, MTI) for any combination of the regions of the part. The MT and 
MTI commands assign a material number to a region, overriding any 
previous material specifications. 

5. The THIC command is used to set the thickness of a shell element. This 
command can be overwritten by another command, THI which is used to 
set the thickness of a shell element in a region of the part. 

6. The EDGE command is used to distribute the nodes along an edge of a 
surface. An edge of the mesh and an edge of the surface must be selected 
before executing this command. This can be done interactively in 
TrueGrid. The edge identifier of the surfaces in the window can be viewed 
by clicking on the Labels and Surf Edge buttons in the environment 
window. By selecting the edge of the mesh and the surface edge identifier 
from the window, the command can be issued. In the Sea TENTACLE 
model, this command was used for the mesh generation of the hull, the 
bow and the platforms. 

7. The SFI command, which is a projection command, is used to project the 
regions of the mesh onto a surface by index progression. Projection 
method is a powerful technique in TrueGrid. This method allows faces, 
edges and nodes of the mesh to be directly placed on surfaces. This 
method can be used interactively. A face of the mesh and a surface must 
be selected prior to the execution of the command. The surface identifier 
in the window can be viewed by clicking on the Labels and Surface 
buttons in the environment window. The projection can be executed by 
selecting the face of the mesh and the surface identifier from the window, 
and clicking the PROJECT button. In the Sea TENTACLE model, this 
command was used for the mesh generation of the hull, the bow and the 
platforms. Figure 76 shows the mesh of the hull of the model before the 
projection onto the surface and after the projection. 
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Figure 76.   The mesh generation of the hull by projection method 
 

8. The global beam cross-section definition BSD is used to define the 
specifications of the cross-section of the beam elements to be created. This 
command has several option lists. For the Sea TENTACLE model, the 
ABAQUS beams option having a rectangular cross-section was selected. 

9. IBMI, JBMI and KBMI are used to create the beam elements in the 
corresponding direction by index progression. This method of beam 
element generation extracts the needed nodes from an existing shell part 
and is a way to embed beam elements within a shell. This is only available 
in part phase. The orientation of the cross section axis is very important in 
the model. It is ensured by orienting the second axis of the cross-section. 
This can be accomplished in three different ways. The first way is 
orienting the second axis in the coordinate axis (i, j or k). The second way 
is orienting the second axis by an orientation vector and the last way is 
orienting the second axis in the normal to a desired surface. In the Sea 
TENTACLE model, the orientation of the beam elements is ensured by 
using orientation vectors. After the MERGE command, which will be 
explained later, the local axes of the beam elements can be displayed by 
using the co or rst command. During the generation of the beam elements, 
the orientation of the beam elements was ensured by using this command 
in the Sea TENTACLE model.  

Before projection 

After projection 

PROJECTION 
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10. The ZTOL command causes each coordinate of each node, whose 
absolute value is less than given tolerance, to be set to zero prior to 
merging and prior to the generation of output. The value 0.0001 was used 
to tolerate the coordinate of each node. 

11. The MERGE command causes the part to end, switches to the merge 
(assembly) phase and merges the individual parts together. 

12. The DELEM LBM command is used to delete the beam elements in the 
mesh. In the Sea TENTACLE model, the beam elements at the 
intersection of the bulkheads and decks were deleted since the corners 
were not stiffened but welded. 

13. The FSET command is used to create a face set. This can be created 
interactively by selecting the SETS button under the PICK option in the 
environment window. After selecting the FACES button, the face of the 
hull under the waterline can be picked interactively. The HIDE drawing 
mode should be used in order to pick only visible elements of the wetted 
surface and the four-node selection option should also be picked for 
easiness since it selects the four nodes of an element and groups as a set. If 
some elements that are not desired in the faceset are selected, they can be 
removed by selecting the REMOVE button and using the one-node 
selection option. After selecting the faces, the set must be named and 
saved. The wetted surface of the ship was grouped into a FACESET 
which was named as “hull”. Creating a set for wetted surface of the ship is 
an important process for coupling the fluid and structural mesh. The 
coupling process will be explained in Appendix D.   

14. The OUTPUT command is used to output the file to a desired format such 
as ABAQUS, LS DYNA, NASTRAN, etc. For the Sea TENTACLE 
model, first the ABAQUS output option and then the WRITE command 
was selected in order to output the file in ABAQUS format. 

According to the procedure described above, the structural mesh was created. The 

TrueGrid code file for the construction of the structural mesh is shown as follows. 
 
iges CatHakanWithNewFront2.igs 1 1 ; 
 
c defining the ABAQUS material for beam elements 
abaqmats 1 aqeltyp b3 aqdens 7850 aqelas aqelis 2.0684e+11 0.3 ; ; ; 
 
c defining the ABAQUS material for shell elements 
abaqmats 2 aqeltyp s aqdens 7850 aqelas aqelis 2.0684e+11 0.3 ; ; ; 
 
bsd 1 cstype 11 abcs1 12e-3 abcs2 0.15;; 
bsd 2 cstype 11 abcs1 14e-3 abcs2 0.15;; 
c bridge 
   
block -1 -26; 
      -1 -16; 
      -1 -7; 
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     -4.40 20.6 
      20.3 35.3 
      3 9 
thic 0.014; 
mate 2; 
c along x-axis 
 jbmi 1 2;1 2;1 2;26 2 1 v 1 0 0 1 
c along z-axis 
 jbmi 1 1;1 2;1 2;1 7 1 v 0 0 1 1; 
 jbmi 2 2;1 2;1 2;1 7 1 v 0 0 1 1; 
c along y-axis  
 kbmi 1 2;1 2;1 2;2 16 1 v 0 1 0 1; 
c along x-axis  
 kbmi 1 2;1 2;1 2;26 2 1 v 1 0 0 1; 
c along y-axis 
 ibmi 1 2;1 2;1 2;16 2 1 v 0 1 0 1; 
c along z-axis 
 ibmi 1 2;1 1;1 2;1 7 1 v 0 0 1 1; 
 ibmi 1 2;2 2;1 2;1 7 1 v 0 0 1 1; 
   
c deck 1 (cic / radio) 
   
block -1 -3 -4 -23 -24 -26; 
      1 -16 -31; 
      -1 -7; 
      -4.4 -2.4 -1.4 17.6 18.6 20.6 
      35.3 50.3 65.3 
      3 9 
thic 0.014; 
mate 2; 
c along x-axis 
jbmi 1 6;1 3;1 2;26 2 1 v 1 0 0 1; 
c along z-axis 
jbmi 1 1;1 3;1 2;1 7 1 v 0 0 1 1; 
jbmi 6 6;1 3;1 2;1 7 1 v 0 0 1 1; 
c along y-axis 
kbmi 1 6;1 3;1 2;2 31 1 v 0 1 0 1; 
c along x-axis  
kbmi 1 6;2 3;1 2;26 2 1 v 1 0 0 1; 
c along y-axis 
ibmi 1 6;1 3;1 2;31 2 1 v 0 1 0 1; 
c along z-axis 
ibmi 1 6;3 3;1 2;1 7 1 v 0 0 1 1; 
   
c deck 1 (wr/cardio/helo)  
 
block -1 -3 -4 -12 -15 -23 -24 -26; 
      1 -16 -24; 
      -1 -7; 
      -4.4 -2.4 -1.4 6.6 9.6 17.6 18.6 20.6 
      65.3 80.3 87.8 
      3 9 
thic 0.014; 
mate 2;   
c along x-axis 
 jbmi 1 8;1 3;1 2;26 2 1 v 1 0 0 1; 
c along z-axis 
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 jbmi 1 1;1 3;1 2;1 7 1 v 0 0 1 1; 
 jbmi 8 8;1 3;1 2;1 7 1 v 0 0 1 1; 
c along y-axis 
 kbmi 1 8;1 3;1 2;2 24 1 v 0 1 0 1; 
c along x-axis 
 kbmi 1 8;2 3;1 2;26 2 1 v 1 0 0 1; 
c along y-axis 
 ibmi 1 8;1 3;1 2;24 2 1 v 0 1 0 1; 
c along z-axis 
 ibmi 1 8;3 3;1 2;1 7 1 v 0 0 1 1; 
   
c main deck (anchor/chain) 
   
block -1 -8 -14 -19 -26; 
      -1 9; 
      -1 -4; 
      -4.4 2.6 8.1 13.6 20.6 
       0 7.8 
       0 3 
thic 0.014; 
mate 2; 
c along x-axis 
 jbmi 1 5;1 2;1 2;26 2 1 v 1 0 0 1; 
c along z-axis 
 jbmi 1 1;1 2;1 2;1 4 1 v 0 0 1 1; 
 jbmi 5 5;1 2;1 2;1 4 1 v 0 0 1 1; 
c along y-axis 
 kbmi 1 5;1 2;1 2;2 9 1 v 0 1 0 1; 
c along x-axis 
 kbmi 1 5;1 1;1 2;26 1 1 v 1 0 0 1; 
c along y-axis 
 ibmi 1 5;1 2;1 2;9 2 1 v 0 1 0 1; 
c along z-axis 
 ibmi 1 5;1 1;1 2;1 4 1 v 0 0 1 1; 
 ibmi 1 5;2 2;1 2;1 4 1 v 0 0 1 1; 
   
c main deck (berthing) 
   
block -1 -8 -10 -17 -19 -26; 
      -1 14; 
      -1 -4; 
      -4.4 2.6 4.6 11.6 13.6 20.6 
       7.8 20.3 
       0 3 
thic 0.014; 
mate 2; 
c along x-axis 
 jbmi 1 6;1 2;1 2;26 2 1 v 1 0 0 1; 
c along z-axis 
 jbmi 1 1;1 2;1 2;1 4 1 v 0 0 1 1; 
 jbmi 6 6;1 2;1 2;1 4 1 v 0 0 1 1; 
c along y-axis  
 kbmi 1 6;1 2;1 2;2 14 1 v 0 1 0 1; 
c along x-axis  
 kbmi 1 6;1 1;1 2;26 1 1 v 1 0 0 1; 
c along y-axis 
 ibmi 1 6;1 2;1 2;14 2 1 v 0 1 0 1; 
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c along z-axis 
 ibmi 1 6;1 1;1 2;1 4 1 v 0 0 1 1; 
   
c main deck (ship off/of.berth./repair) 
   
block -1 -8 -10 -17 -19 -26; 
      -1 9; 
      -1 4; 
      -4.4 2.6 4.6 11.6 13.6 20.6 
       20.3 28.3 
       0 3 
thic 0.014; 
mate 2; 
c along x-axis 
 jbmi 1 6;1 2;1 1;26 2 1 v 1 0 0 1; 
c along z-axis 
 jbmi 1 1;1 2;1 2;1 4 1 v 0 0 1 1; 
 jbmi 6 6;1 2;1 2;1 4 1 v 0 0 1 1; 
c along y-axis  
 kbmi 1 6;1 2;1 2;2 9 1 v 0 1 0 1; 
c along x-axis  
 kbmi 1 6;1 1;1 2;26 1 1 v 1 0 0 1; 
c along y-axis 
 ibmi 1 6;1 2;1 1;9 1 1 v 0 1 0 1; 
c along z-axis 
 ibmi 1 6;1 1;1 2;1 4 1 v 0 0 1 1; 
   
c main deck (med./gym/storage) 
   
block -1 -8 -10 -17 -19 -26; 
      -1 8; 
      -1 4; 
      -4.4 2.6 4.6 11.6 13.6 20.6 
       28.3 35.3 
       0 3 
thic 0.014; 
mate 2; 
c along x-axis 
 jbmi 1 6;1 2;1 1;26 2 1 v 1 0 0 1; 
c along z-axis 
 jbmi 1 1;1 2;1 2;1 4 1 v 0 0 1 1; 
 jbmi 6 6;1 2;1 2;1 4 1 v 0 0 1 1; 
c along y-axis 
 kbmi 1 6;1 2;1 2;2 8 1 v 0 1 0 1; 
c along x-axis  
 kbmi 1 6;1 1;1 2;26 1 1 v 1 0 0 1; 
c along y-axis 
 ibmi 1 6;1 2;1 1;8 1 1 v 0 1 0 1; 
c along z-axis 
 ibmi 1 6;1 1;1 2;1 4 1 v 0 0 1 1; 
   
c main deck (uuvs 1) 
   
block -1 -3 -24 -26; 
      -1 16; 
      -1 4; 
      -4.4 -2.4 18.6 20.6 



108 

       35.3 50.3 
       0 3 
thic 0.014; 
mate 2;   
c along x-axis 
 jbmi 1 4;1 2;1 1;26 2 1 v 1 0 0 1; 
c along z-axis 
 jbmi 1 1;1 2;1 2;1 4 1 v 0 0 1 1; 
 jbmi 4 4;1 2;1 2;1 4 1 v 0 0 1 1; 
c along y-axis  
 kbmi 1 4;1 2;1 2;2 16 1 v 0 1 0 1; 
c along x-axis  
 kbmi 1 4;1 1;1 2;26 1 1 v 1 0 0 1; 
c along y-axis 
 ibmi 1 4;1 2;1 1;16 1 1 v 0 1 0 1; 
c along z-axis 
 ibmi 1 4;1 1;1 2;1 4 1 v 0 0 1 1; 
   
c main deck (ramp) 
   
block -1 -3 -4 -23 -24 -26; 
      -1 16; 
      -1 4; 
      -4.4 -2.4 -1.4 17.6 18.6 20.6 
       50.3 65.3 
       0 3 
thic 0.014; 
mate 2;  
c along x-axis 
 jbmi 1 6;1 2;1 1;26 2 1 v 1 0 0 1; 
c along z-axis 
 jbmi 1 1;1 2;1 2;1 4 1 v 0 0 1 1; 
 jbmi 6 6;1 2;1 2;1 4 1 v 0 0 1 1; 
c along y-axis  
 kbmi 1 6;1 2;1 2;2 16 1 v 0 1 0 1; 
c along x-axis  
 kbmi 1 6;1 1;1 2;26 1 1 v 1 0 0 1; 
c along y-axis 
 ibmi 1 6;1 2;1 1;16 1 1 v 0 1 0 1; 
c along z-axis 
 ibmi 1 6;1 1;1 2;1 4 1 v 0 0 1 1; 
   
c main deck (uuvs 2) 
   
block -1 -13 -14 -26; 
      -1 16; 
      -1 4; 
      -4.4 7.6 8.6 20.6 
       65.3 80.3 
       0 3 
thic 0.014; 
mate 2; 
c along x-axis 
 jbmi 1 4;1 2;1 1;26 2 1 v 1 0 0 1; 
c along z-axis 
 jbmi 1 1;1 2;1 2;1 4 1 v 0 0 1 1; 
 jbmi 4 4;1 2;1 2;1 4 1 v 0 0 1 1; 
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c along y-axis  
 kbmi 1 4;1 2;1 2;2 16 1 v 0 1 0 1; 
c along x-axis  
 kbmi 1 4;1 1;1 2;26 1 1 v 1 0 0 1; 
c along y-axis 
 ibmi 1 4;1 2;1 1;16 1 1 v 0 1 0 1; 
c along z-axis 
 ibmi 1 4;1 1;1 2;1 4 1 v 0 0 1 1; 
   
c main deck (post off/wld-1) 
   
block -1 -3 -4 -12 -15 -23 -24 -26; 
      -1 9; 
      -1 4; 
      -4.4 -2.4 -1.4 6.6 9.6 17.6 18.6 20.6 
       80.3 87.8 
       0 3 
thic 0.014; 
mate 2;   
c along x-axis 
 jbmi 1 8;1 2;1 1;26 2 1 v 1 0 0 1; 
c along z-axis 
 jbmi 1 1;1 2;1 2;1 4 1 v 0 0 1 1; 
 jbmi 8 8;1 2;1 2;1 4 1 v 0 0 1 1; 
c along y-axis  
 kbmi 1 8;1 2;1 2;2 9 1 v 0 1 0  1; 
c along x-axis 
 kbmi 1 8;1 1;1 2;26 1 1 v 1 0 0 1; 
c along y-axis 
 ibmi 1 8;1 2;1 1;9 1 1 v 0 1 0  1; 
c along z-axis 
 ibmi 1 8;1 1;1 2;1 4 1 v 0 0 1 1; 
   
c main deck (enlisted berth./uuv workshop) 
   
block -1 -13 -14 -26; 
      -1 -23; 
      -1 -4; 
      -4.4 7.6 8.6 20.6 
       87.8 110 
       0 3 
thic 0.014; 
mate 2;   
c along x-axis 
 jbmi 1 4;1 2;1 2;26 2 1 v 1 0 0 1; 
c along z-axis 
 jbmi 1 1;1 2;1 2;1 4 1 v 0 0 1 1; 
 jbmi 4 4;1 2;1 2;1 4 1 v 0 0 1 1; 
c along y-axis  
 kbmi 1 4;1 2;1 2;2 23 1 v 0 1 0  1; 
c along x-axis 
 kbmi 1 4;1 2;1 2;26 2 1 v 1 0 0 1; 
c along y-axis 
 ibmi 1 4;1 2;1 2;23 2 1 v 0 1 0  1; 
c along z-axis 
 ibmi 1 4;1 1;1 2;1 4 1 v 0 0 1 1; 
 ibmi 1 4;2 2;1 2;1 4 1 v 0 0 1 1;  
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c left hull 
   
block -1 -10; 
      -1 -9 -22 -37 -52 -67 -82 -90 -98 -113; 
       1 -8; 
      -4.4 4.4 
       0 7.80 20.3 35.3 50.3 65.3 80.3 87.8 95.3 110 
       0 -7.48 
thic 0.014; 
mate 2;  
 
c along z-axis 
 jbmi 1 1;1 10;1 2;1 8 1 v 0 0 1 2; 
 jbmi 2 2;1 10;1 2;1 8 1 v 0 0 1 2; 
c along y-axis  
 kbmi 1 1;1 10;1 2;1 111 1 v 0 1 0 2; 
 kbmi 2 2;1 10;1 2;1 111 1 v 0 1 0 2; 
c along x-axis  
 kbmi 1 2;1 10;1 2;26 2 1 v 1 0 0 2; 
c along y-axis 
 ibmi 1 2;1 10;2 2;111 1 1 v 0 1 0 2; 
c along z-axis 
 ibmi 1 2;1 1;1 2;1 8 1 v 0 0 1 2; 
 ibmi 1 2;2 2;1 2;1 8 1 v 0 0 1 2; 
 ibmi 1 2;3 3;1 2;1 8 1 v 0 0 1 2; 
 ibmi 1 2;4 4;1 2;1 8 1 v 0 0 1 2; 
 ibmi 1 2;5 5;1 2;1 8 1 v 0 0 1 2; 
 ibmi 1 2;6 6;1 2;1 8 1 v 0 0 1 2; 
 ibmi 1 2;7 7;1 2;1 8 1 v 0 0 1 2; 
 ibmi 1 2;8 8;1 2;1 8 1 v 0 0 1 2; 
 ibmi 1 2;9 9;1 2;1 8 1 v 0 0 1 2; 
 ibmi 1 2;10 10;1 2;1 8 1 v 0 0 1 2; 
   
   
c projection of left hull 
   
edge 1 10 2 2 10 2 91.2 
edge 1 10 1 1 10 2 91.2 
edge 2 10 1 2 10 2 91.2 
edge 1 10 2 2 10 2 91.2 
edge 1 10 1 2 10 1 91.1 
sfi 1 2; -10; 1 2;sd 91 
sfi -1 0 -2; 1 10; 1 2;sd 3 
edge 1 1 2 2 1 2 3.1 
sfi 1 2; 1 10; -2;sd 3 
   
c right hull 
   
block -1 -10; 
      -1 -9 -22 -37 -52 -67 -82 -90 -98 -113; 
       1 -8; 
      11.8 20.6 
      0 7.80 20.3 35.3 50.3 65.3 80.3 87.8 95.3 110 
      0 -7.48 
thic 0.014; 
mate 2;   
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c along z-axis 
 jbmi 1 1;1 10;1 2;1 8 1 v 0 0 1 2; 
 jbmi 2 2;1 10;1 2;1 8 1 v 0 0 1 2; 
c along y-axis  
 kbmi 1 1;1 10;1 2;1 111 1 v 0 1 0 2; 
 kbmi 2 2;1 10;1 2;1 111 1 v 0 1 0 2; 
c along x-axis  
 kbmi 1 2;1 10;1 2;26 2 1 v 1 0 0 2; 
c along y-axis 
 ibmi 1 2;1 10;2 2;111 1 1 v 0 1 0 2; 
c along z-axis 
 ibmi 1 2;1 1;1 2;1 8 1 v 0 0 1 2; 
 ibmi 1 2;2 2;1 2;1 8 1 v 0 0 1 2; 
 ibmi 1 2;3 3;1 2;1 8 1 v 0 0 1 2; 
 ibmi 1 2;4 4;1 2;1 8 1 v 0 0 1 2; 
 ibmi 1 2;5 5;1 2;1 8 1 v 0 0 1 2; 
 ibmi 1 2;6 6;1 2;1 8 1 v 0 0 1 2; 
 ibmi 1 2;7 7;1 2;1 8 1 v 0 0 1 2; 
 ibmi 1 2;8 8;1 2;1 8 1 v 0 0 1 2; 
 ibmi 1 2;9 9;1 2;1 8 1 v 0 0 1 2; 
 ibmi 1 2;10 10;1 2;1 8 1 v 0 0 1 2; 
   
c projection of right hull 
   
edge 1 1 2 2 1 2 86.1 
edge 1 1 1 1 1 2 86.1 
edge 2 1 1 2 1 2 86.1 
edge 1 10 2 2 10 2 94.2 
edge 2 10 1 2 10 2 86.3 
edge 1 10 1 1 10 2 94.2 
edge 1 10 2 2 10 2 94.2 
edge 1 10 1 2 10 1 94.1 
sfi -1 0 -2; 1 10; 1 2;sd 86 
sfi 1 2; 1 10; -2;sd 86 
   
c left bow 
   
block -1 -10; 
       1 -8; 
      -1 -8; 
      -4.4 4.4 
       0 -7.48 
       0 -7.48 
thic 0.014; 
mate 2;   
c along y-axis (problem with i) 
 kbmi 1 1;1 2;1 2;1 8 1 v 0 1 0 2; 
 kbmi 2 2;1 2;1 2;1 8 1 v 0 1 0 2; 
c along z-axis 
 jbmi 1 1;1 2;1 2;1 8 1 v 0 0 1 2; 
 jbmi 2 2;1 2;1 2;1 8 1 v 0 0 1 2; 
   
c along y-axis 
 ibmi 1 2;1 2;1 2;8 2 1 v 0 1 0 2; 
 ibmi 1 2;2 2;2 2;1 1 1 v 0 0 1 2; 
 ibmi 1 2;2 2;1 1;1 1 1 v 0 0 1 2; 
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c projection of left bow 
   
edge 1 2 1 2 2 1 5.1 
edge 2 2 1 2 2 2 5.1 
edge 2 1 1 2 2 1 5.1 
edge 1 1 1 2 1 1 93.2 
edge 1 1 1 1 2 1 5.1 
sfi 1 2; 1 2; -1;sd 93 
sfi -2; 1 2; 1 2;sd 5 
sfi 1 2; 1 2; -2;sd 5 
sfi -1; 1 2; 1 2;sd 5 
sfi -2; 1 2; 1 2;sd 5 
sfi 1 2; -2; 1 2;sd 5 
   
c right bow 
   
block -1 -10; 
       1 -8; 
      -1 -8; 
      11.8 20.6 
      0 -7.48 
      0 -7.48 
thic 0.014; 
mate 2; 
c along y-axis (problem with i) 
 kbmi 1 1;1 2;1 2;1 8 1 v 0 1 0 2; 
 kbmi 2 2;1 2;1 2;1 8 1 v 0 1 0 2; 
c along z-axis 
 jbmi 1 1;1 2;1 2;1 8 1 v 0 0 1 2; 
 jbmi 2 2;1 2;1 2;1 8 1 v 0 0 1 2; 
   
c along y-axis 
 ibmi 1 2;1 2;1 2;8 2 1 v 0 1 0 2; 
 ibmi 1 2;2 2;2 2;1 1 1 v 0 0 1 2; 
 ibmi 1 2;2 2;1 1;1 1 1 v 0 0 1 2; 
   
c projection of right bow 
   
edge 1 2 1 2 2 1 92.1 
edge 2 1 1 2 2 1 92.1 
edge 1 1 1 1 2 1 92.1 
sfi -1; 1 2; 1 2;sd 88 
sfi -2; 1 2; 1 2;sd 88 
sfi 1 2; 1 2; -1;sd 92 
sfi 1 2; 1 2; -2;sd 88 
sfi 1 2; -2; 1 2;sd 88 
   
c 1st platform port 
   
block 1 9; 
      1 118; 
      1 ; 
     -3.89 3.89 
     -7.48 110 
     -3.5 
thic 0.014; 
mate 2;  
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c along x-axis (problem with i) 
 jbmi 1 2;1 2;1 1;9 1 1 v 1 0 0 2; 
   
c along y-axis 
 ibmi 1 2;1 2;1 1;118 1 1 v 0 1 0 2; 
   
c projection of 1st platform port 
   
edge 1 1 1 2 1 1 90.1 
edge 2 1 1 2 2 1 90.1 
edge 1 1 1 1 2 1 90.1 
edge 1 2 1 2 2 1 90.2 
sfi 1 2; 1 2; -1; sd 90 
   
c 1st platform starboard 
   
block 1 9; 
      1 118; 
      1; 
      12.31 20.09 
     -7.48 110 
     -3.5 
thic 0.014; 
mate 2;   
c along x-axis (problem with i) 
 jbmi 1 2;1 2;1 1;9 1 1 v 1 0 0 2; 
   
c along y-axis 
 ibmi 1 2;1 2;1 1;118 1 1 v 0 1 0 2; 
   
c projection of 1st platform starboard 
   
edge 1 1 1 2 1 1 89.1 
edge 2 1 1 2 2 1 89.1 
edge 1 1 1 1 2 1 89.1 
edge 1 2 1 2 2 1 89.1 
edge 1 2 1 2 2 1 89.2 
sfi 1 2; 1 2; -1; sd 89 
ztol 0.0001; 
merge 
 
delem lbm 8839 8838 8837 8836 8835 8834; 
delem lbm 9145 9144 9143 9142 9141 9140; 
delem lbm . .  . .  . .  . .  . .  . . ; 
   
fset hull = ls 
c linear shells 
12999:13030 13094:13165 13205:13256 13320:13436 13482:13541 13605:13739  
...  ...  ...  ...  ...  ... 
sd 999 faceset hull ;   
 

abaqus 

c  output file name is trugrdo                                  

c  creating ABAQUS input deck 

write 
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APPENDIX C.   FLUID MODELING OF SEA TENTACLE MODEL 
USING ABAQUS/CAE 

This appendix covers the process for generating the fluid finite element mesh by 

using ABAQUS. ABAQUS is an advanced finite element analysis that provides complete 

and powerful solutions for linear and nonlinear engineering problems. It is a suite of 

finite element analysis modules. ABAQUS/CAE, having a modern graphical user 

interface (GUI) of menus, icons, and dialog boxes, provides the most complete interface 

with the ABAQUS solver programs available [Ref. 22]. The fluid mesh generation in 

ABAQUS/CAE is described as follows. In order to understand the process, the user 

should be familiar with the components of the ABAQUS/CAE and the appearance of the 

window. Figure 77 shows the components that appear in the main window.  

 
Figure 77.   Components of the main window in ABAQUS/CAE [Ref. 22] 
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1. Geometry can be imported from other packages with several file formats 
in ABAQUS/CAE. The best choice for importing geometry is importing it 
as an SAT file.  From the main menu bar: 

File → Import → Part → Input the SAT file → Accept the conversion 
to precise representation → Select the solid topology → Click OK 
(Figure 78) 
 

 
 

Figure 78.   Creating Part Dialog Box 
 

2. The surfaces should be created in Part phase since they will be used in the 
Interaction phase. As shown in Figure 79, the nonreflecting circular and 
spherical surfaces are created in order to define the acoustic impedance in 
the Interaction phase. From the main menu bar: 

Tools → Surface → Create → Name the geometry → Select the 
regions interactively → Click DONE in the prompt area  

 

 
Figure 79.   Nonreflecting circular and spherical surfaces  
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3. The fluid material should be defined as an acoustic medium. From the tool 
bar, go to the Property Module and from the main menu bar: 

Material → Create → Name the material → Select Other menu → 
Acoustic Medium → Enter the Bulk Modulus → Select General menu 
→ Enter the mass density (Figure 80) 
 

4. The section properties of a model can be defined by creating a section in 
the Property Module. Since the fluid mesh should have solid elements, a 
homogeneous solid section should be created. A homogeneous solid 
section is the simplest section type that the user can define. It includes 
only a material reference and a plane stress/plane strain thickness. From 
the main menu bar: 

Section → Create → Select Solid Category → Accept Homogeneous as 
the default category section → Click Continue (Figure 81) 
 
The solid section editor appears. In the Edit Section dialog box: 
 
Select Material → Accept the default value of 1 for Plane stress/strain 
thickness → Click OK (Figure 81) 
 

 
 

Figure 80.   Material Editor Dialog Box 
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Figure 81.   Creating and Editing Section  

 
5. Each part created is oriented in its own coordinate system and is 

independent of the other parts in the model. The Assembly module is used 
to define the geometry of the finished model by creating instances of a 
part. Although a model may contain many parts, it contains only one 
assembly.  From the tool bar, go to the Assembly Module and from the 
main menu bar: 

Instance → Create → Select the dependent instance type → Click OK  

 
Figure 82.   Creating Instance  

 
6. The Mesh module is used to generate the finite element mesh. The 

meshing techniques, which ABAQUS/CAE will use to create the mesh, 
the element type and shape can be chosen. For the Sea TENTACLE 
model, the element type of the fluid mesh should be the acoustic type. 
From the tool bar, go to the Mesh Module and select the fluid part from 
the Object menu. From the main menu bar: 

Mesh → Element Type → Select Acoustic Finite Element → Select 
Tetrahedral Element (AC3D4) → Click OK (Figure 83) 
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7. The Mesh Controls dialog box is used to examine the technique that 
ABAQUS/CAE will use. After assigning this element shape, the color of 
the part should be turned to purple. From the main menu bar: 

Mesh → Mesh Controls → Select Tetrahedral as the element shape → 
Click OK (Figure 84) 

 
Figure 83.   Selecting the Element Type 

 
Figure 84.   Mesh Control Dialog Box 
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8. The number of seeds should be selected prior to the meshing process. It 
can be accomplished by entering the approximate global seed size. For the 
Sea TENTACLE model, 1 m was input as the global element size. From 
the main menu bar: 

Seed → Part → Enter the approximate global size of the element → 
Accept the other values as default → Click Apply and OK 

 
Figure 85.   Defining the Element Size 

 
9. In order to finish the meshing process, from the main menu bar: 

Mesh → Part → Click Yes to confirm the meshing in the prompt area 
  

The final mesh of the fluid mesh is displayed and the information about the mesh 

is given at the message prompt of ABAQUS/CAE. 
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APPENDIX D.   COUPLING THE FLUID/STRUCTURAL MESH 
AND UNDEX ANALYSIS OF SEA TENTACLE MODEL BY USING 

ABAQUS/CAE  

ABAQUS/CAE incorporates the analysis modules into a Complete ABAQUS 

Environment for modeling, managing, and monitoring ABAQUS analyses and 

visualizing results. It also introduces the generalized force on acoustic and solid media 

associated with the arrival of dilatational waves. Since the fluid mechanics is assumed to 

be linear, the wave fields in the fluid can be superimposed in a dynamic problem excited 

by a propagating wave in the fluid arriving from outside the domain [Ref. 22].  

The fluid mesh and structural mesh should be coupled in order to couple the 

response of the structure to that of the fluid. This can be done by creating a TIE constraint 

in ABAQUS/CAE.  This appendix covers the coupling process and UNDEX analysis for 

the Sea TENTACLE model.  

1. The structural input file created in TrueGrid can be imported as a model in 
ABAQUS/CAE. From the main menu bar: 

File → Import → Model → Select the ABAQUS input file for the 
structural model 

2. After importing the model, checking the features, sets, sections, and profiles 
of the structural model is strongly encouraged. From the model tree: 

Click Parts → Click PART-1 → Check the desired features 
3. The fluid mesh can be created under the imported model tree as described in 

Appendix C. 

4. After creating the fluid mesh, some surfaces of the fluid part should be 
defined prior to UNDEX analysis steps. The surface that will be coupled with 
the wetted surface of the ship and the exterior face of the fluid part that 
interacts with the charge should be defined as surfaces. These surfaces will be 
used in the Interaction Module for easier accessibility. In the Mesh Module: 

Tools → Surface → Create → Name the surface → Click OK → Select 
the region which will be coupled with the wetted surface of the ship (Do 
the same process for the exterior fluid surface) 
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Figure 86.   Creating Surface Dialog Box 

 

5. Coupling the fluid and structural mesh can be done by the TIE option. From 
the tool bar, go to the Interaction Module and from the main menu bar: 

Constraint → Select TIE → Click OK → Choose the wetted surface of the 
ship as the master surface from the Surfaces option in the prompt area → 
Click Continue → Choose the fluid surface, FLUIDWETTED which was 
created in Step 4 as the slave surface from the Surfaces option in the 
prompt area → Click Continue → Click OK in the Edit Constraint 
window 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 87.   Applying Constraint on the Model 

 



123 

6. After coupling the fluid-structural meshes, the next step is to create a specific 
analysis step. ABAQUS/CAE creates a special initial step at the beginning of 
the model’s step sequence that allows the user to define the boundary 
conditions, fields and interactions that are applicable at the beginning of the 
analysis. The initial step is followed by one or more specific analysis steps.  
Incident wave loads are supported only in transient dynamic procedures.  
From the tool bar, go to the Interaction Module and from the main menu bar: 

Step → Create → Select Dynamic, Explicit 

 

 

 

 

 

 

 

 

 

 

Figure 88.   Creating the Step 
 

7. The step editor appears. In the editor window, the step properties should be 
defined. The incrementation of the step is of considerable interest. ABAQUS 
automatically subdivides a large time step into several smaller increments if it 
finds that the solution is nonlinear by using the Newton-Raphson iteration. 
This process is completely automatic, and ABAQUS will always take the 
largest possible time increments that will reach the end of the step and still 
give an accurate, convergent solution.  

 
Select Basic tab → Name the step → Enter the desired time period (In 
Sea TENTACLE model, it was input as 0.5 seconds) → Select 
Incrementation tab → Select automatic type → Accept the default value 
of 1 for time scaling factor → Select Other tab → Enter the linear and 
quadratic bulk viscosity parameters (default values are shown in the 
figure) 
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Figure 89.   Defining the Dynamic Step 

 
 

8. The location of the charge and the stand-off point should be defined as 
reference points prior to the interaction. From the main menu bar: 

Tools → Reference Point → Enter the location of the point at where the 
charge locates in the prompt area → Enter (Do the same process for the 
stand off point) 

 

 
 

Figure 90.   Defining a Reference Point in the Prompt Area 
 

9. The explosive load is specified with an incident wave load in UNDEX 
analysis. The load is applied on both the structure and the fluid at their 
common interface. The load is similar to a distributed load and the charge can 
be located outside the acoustic domain in ABAQUS/CAE. UNDEX analysis 
is tracked beginning at the standoff point. From the main menu bar: 

Interaction → Create → Select Incident Wave → Click Continue → 
Select the type of region → Click on the first reference point and second 
reference point in the viewport interactively → Select the exterior fluid 
surface from the Surfaces option in the prompt area (Figure 91) 
 

10. Interaction editor appears. In the interaction editor window: 

Select the UNDEX from definition tab → Create Wave property → Select 
Incident Wave → Click OK (Figure 91) 
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Figure 91.   Creating Incident Wave Interaction for the Model 
 
 

11. Continue with the interaction editor. The charge used in the Sea TENTACLE 
model analysis is TNT. Since the metric system was used in the Sea 
TENTACLE model, all the values in Figure 92 are in metric system except the 
constants A and B that are dimensionless. 

Input the speed of sound and fluid mass density → Select the Spherical 
Wave definition → Click on the Use UNDEX Charge → Input the 
physical, material and bubble model step data  
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Figure 92.   Defining the Properties of TNT Charge  
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12. Acoustic impedance is used to provide surface impedance information or 
nonreflecting boundaries for acoustic and coupled fluid-structural analysis. It 
states that acoustic energy leaves the mesh through a nonreflecting boundary. 
The nonreflecting type depends on the boundary geometry. In this thesis, fluid 
mesh consists of two spherical and one circular surface that were created 
separately in the Part phase. Therefore, the boundary type should be spherical 
and circular. From the main menu bar: 

Interaction → Create → Name the interaction → Select Step-1 from the 
Step menu → Select Acoustic Impedance option → Click Continue → 
Select the one of the exterior surface of the fluid mesh as the boundary 
from the Surfaces option → Click Continue → Select Nonreflecting 
impedance definition in the Interaction editor window → Select 
Circular/Spherical as nonreflecting type and enter the radius of the 
geometry → Click OK (Repeat this process for each boundary surfaces) 
 

 

 
 

Figure 93.   Creating Acoustic Impedance Interaction 
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13. The dynamic acoustic pressure boundary condition on the free surface 

requires a zero pressure boundary condition on this surface in UNDEX 
phenomena. From the tool bar, go to the Load module and from the main 
menu bar: 

BC → Create → Select Other from Category option → Select Acoustic 
pressure as the BC type → Click Continue → Select the free surface of 
the fluid as the BC location in the viewport interactively → Input 0 as the 
magnitude of the pressure at the free surface → Click OK 
 

     
 

Figure 94.   Creating the Boundary Condition at the Free Surface 
 

14. The next step is to create the output requests. Field output variables are 
generally written at relatively low frequencies to the output database for the 
entire model. The velocity, acceleration and acoustic pressure are the main 
important field output variables for UNDEX analysis. The dynamics of the 
shock front can easily be seen in the plots by selecting the acoustic pressure 
variable as an output. From the tool bar, go to Step module and from the main 
menu bar: 

Output → Field Output Resuests → Create → Select the whole model as 
the domain → Select Evenly Spaced Time Intervals as the frequency of 
obtaining the output → Input the desired time interval → Select Output 
at approximate times for timing → Select the desired output variables 
seperately (Displacement/Velocity/Acceleration, Acoustics and Stress etc) 
→ Click OK 
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Figure 95.   Field Output Request 
 

15. History output variables are generally written at relatively high frequencies to 
the output database for a small portion or node of the model. The 
velocity/acceleration is the main important history output variable for 
UNDEX analysis. The velocity history at critical points in the structure 
indicates the severity with which the shock has influenced the structure. From 
the main menu bar: 

Output → History Output Requests → Create → Select the set as domain 
→ Select the desired point/node → Pick every n time increments as the 
frequency → Input 1 as n value → Select the desired output variables 
(Displacement/Velocity/Acceleration) → Click OK 
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Figure 96.   History Output Request 

 

16. The next step is to edit the attribute of the model. The formulation type should 
be defined at this step. Total wave formulation was used in the Sea 
TENTACLE model. From the model tree: 

Right Click on the model name → Click Edit Attributes → In the editor 
window, specify acoustic wave formulation (Figure 97) 
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Figure 97.   Specifying Total Wave Formulation 

 
17. Some of the functions in UNDEX analysis are not supported in 

ABAQUS/CAE. Therefore, they have to be invoked by using keywords 
editor. From the model tree: 

Right Click on the model name → Click Edit Keywords → In the editor 
window: 

Define the cavitation limit in pressure magnitude under the Materials 
option: 

*Acoustic Medium, Cavitation Limit 

0.0, 

Define the bubble loading in order to visualize the bubble history under 

the Interactions option:  

*Amplitude, Definition=Bubble, Name=Bubble, 

Time=Total 
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First Line:  

 Charge material constant K, k, A, B, adiabatic charge constant Kc, 

ratio of specific heats for gas, density of charge material, mass of 

charge material, charge depth  

52.1E6,9E-005,0.18,0.185,839600000,1.27,1500, 

3401.94, 57.0 

Second Line:  

 Fluid mass density, sound speed in fluid, X-direction of cosine of fluid 

surface normal, Y-direction of cosine of fluid surface normal, Z-

direction of cosine of fluid surface normal  

1025.0, 1500.0, 0.0, 0.0, 1.0 

Third Line:  

 Gravitational acceleration, atmospheric pressure, wave effect 

parameter, flow drag coefficient  

9.8066, 101320, 1.0, 2.0 

Fourth Line:  

 Time duration, maximum number of time steps, relative step size, 

absolute step size, step size control exponent  

1.5, 1500, 1E-011, 1E-011, 0.2 

Define the acoustic static pressure at two reference points as an initial 

condition:  

*Initial Conditions, Type=Acoustic Static 

Pressure  

fluid_spherical-1.FLUID,0,8.08768177,-

30.5471306, -2.75, 251381.25, 8.10000038, -

7.48000002, -27.75 
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18. The Job module is used to create and configure the analysis jobs. Submitting a 
job to ABAQUS/Standard or ABAQUS/Explicit for analysis generates the 
input files and submits them as analysis jobs. The input file can be created 
without submitting the job. From the tool bar, go to the Job module and from 
the main menu bar: 

Job → Create → Select the model → Click Continue → Name the 
description of the job → Select the Full Analysis from the Submission tab 
→ Input the file processor memory as the maximum memory of the 
machine that will be used for the analysis. (Figure 98) 

19. The final step is submitting the job and running the analysis. From the main 
menu bar: 

Job → Manager → Click on Submit (Click on Write Input in order to 
create the input file without running the analysis) (Figure 99) 

 

  
 

Figure 98.   Creating the Job for Simulation 
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Figure 99.   Job Manager Dialog Box 
 

The input file of the model is summarized as follows. 
 

**  
** MATERIALS 
**  
*Material, name=M1 
*Damping, alpha=19.2, beta=2.09e-06 
*Density 
7850., 
*Elastic 
 2.07e+11, 0.3 
*Material, name=M2 
*Damping, alpha=19.2, beta=2.09e-06 
*Density 
7850., 
*Elastic 
 2.07e+11, 0.3 
*Material, name=WATER 
*Acoustic Medium 
 2.1404e+09, 
*Density 
1025., 
**  
** INTERACTION PROPERTIES 
**  
*Incident Wave Interaction Property, name=INTPROP-1, 
type=SPHERE 
1500., 1025. 
*UNDEX Charge Property 
5.21e+07, 9e-05, 0.18, 0.185, 8.396e+08, 1.27 
1500., 3401.94, 9.8066, 101320., 1.0, 2. 
1.5, 1500, 1e-11, 1e-11, 0.2 
57., 0., 0., 1. 



135 

 
**  
** PHYSICAL CONSTANTS 
**  
*Acoustic Wave Formulation, type=TOTAL WAVE 
** -------------------------------------------------------- 
*Initial Conditions, Type=Acoustic Static Pressure  
fluid_spherical-1.FLUID, 0, 8.08768177, -30.5471306, -2.75, 
251381.25, 8.10000038, -7.48000002, -27.75 
**  
** STEP: Step-1 
**  
*Step, name=Step-1 
model_step 
*Dynamic, Explicit 
, 1.5 
*Bulk Viscosity 
0.06, 1.2 
**  
** BOUNDARY CONDITIONS 
**  
** Name: Aco-BC-1 Type: Acoustic pressure 
*Boundary 
FLUID_SPHERICAL-1.FREESURFACE, 8, 8 
**  
** INTERACTIONS 
**  
** Interaction: AcSimp-1 
*Simpedance, nonreflecting=SPHERICAL 
FLUID_SPHERICAL-1.FLUIDSPHERICAL_1, 25. 
** Interaction: AcSimp-2 
*Simpedance, nonreflecting=SPHERICAL 
FLUID_SPHERICAL-1.FLUIDSPHERICAL_2, 25. 
** Interaction: AcSimp-3 
*Simpedance, nonreflecting=CIRCULAR 
FLUID_SPHERICAL-1.FLUIDCIRCULAR, 25. 
** Interaction: IncWave-1 
*Incident wave interaction, UNDEX, property=INTPROP-1 
FLUID_SPHERICAL-1.FLUIDEXT,_PICKEDSET28,_PICKEDSET29, 1. 
**  
** OUTPUT REQUESTS 
**  
*Restart, write, number interval=1, time marks=NO 
**  
** FIELD OUTPUT: F-Output-1 
**  
*Output, field, number interval=100 
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*Node Output 
PABS, POR 
**  
** FIELD OUTPUT: F-Output-2 
**  
*Element Output, directions=YES 
S,  
**  
** FIELD OUTPUT: F-Output-3 
**  
*Node Output 
U, V 
**  
** HISTORY OUTPUT: H-Output-1 
**  
*Output, history, frequency=1 
*Node Output, nset=PART-1-1.GAP_MAIN01 
A1, A2, A3, U1, U2, U3, V1, V2 
V3 
** 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



137 

LIST OF REFERENCES 

1. NAVSHIPS 250-660-26, “Mechanical Shock on Naval Vessels,” March 1946 

2. NSWCCD/UERD, www.dt.navy.mil/sur-str-mat/sur-wea-eff/his, September 
2006. 

3. OPNAV Instruction 9072.2, “Shock Hardening of Surface Ships,” 12 January 
1987. 

4. NAVSEA 0908-LP-000-3010A, Shock Design Criteria for Surface Ships, October 
1994. 

5. Military Specification, MIL-S-901D, Shock Tests, High Impact Shipboard 
Machinery, Equipment and Systems, Requirements for, March 1989. 

6. USS John Paul Jones (DDG-53) Shock Trial Final Report, AEGIS Program 
Manager (PMS-400), November 1994. 

7. DOT&E FY97 Annual Report, 
www.globalsecurity.org/military/library/budget/fy1997/dot-e/navy/97ddg51.html, 
September 2006. 

8. Shin, Y. S. and Schneider, N. A., “Ship Shock Trial Simulation of USS Winston 
S. Churchill (DDG-81):  Modeling and Simulation Strategy and Surrounding 
Fluid Volume Effects” Proceedings of the 74th Shock and Vibration Symposium, 
San Diego, CA, 27-31 October 2003. 

9. Shin, Y. S., “Ship Shock Modeling and Simulation for Far-field Underwater 
Explosion,” Computers & Structures, 82 (2004) 2211-2219. 

10. Shin, Y. S., “Naval Ship Shock and Design Analysis” Course Notes for 
Underwater Shock Analysis, Naval Postgraduate School, Monterey, California, 
2006. 

11. Cole, R. H., Underwater Explosions, pp. 1-15, Princeton University Press, 1948. 

12. DeRuntz, Jr., J. A., The Underwater Shock Analysis (USA) Manual, Unique 
Software Applications, Colorado Springs, Colorado, May 1996. 

13. Arons, A. B., et al., “Long Range Shock Propagation in Underwater Explosion 
Phenomena II,” Underwater Explosion Compendium, Vol. 1, October 1949. 

14. Didoszak, J. M., “Parametric Studies of DDG-81 Ship Shock Trial Simulations,” 
Master’s Thesis, Naval Postgraduate School, Monterey, California, 2004. 



138 

15. Shin, Y. S., “LS-DYNA Training Guide: Nonlinear Dynamic Analysis of 
Structures in 3-D Code Coupled with Underwater Shock Analysis Code for Ship 
Shock Modeling and Simulation,” Naval Postgraduate School, July 2002. 

16. DeRuntz, Jr., J. A. “The Underwater Shock Analysis Code and Its Applications,” 
60th Shock and Vibration Symposium, Vol. I, pp. 89-107, November 1989. 

17. Geers, T. L., “Doubly Asymptotic Approximations for Transient Motions of 
Submerged Structures,” Journal of the Acoustical Society of America, Vol. 64, pp 
1500-1508, 1978. 

18. DeRuntz, Jr. J. A. and Rankin, C.C., “Applications of the USA-STAGS-CFA 
Code to Nonlinear Fluid-Structure Interaction Problems in Underwater Shock of 
Submerged Structures,” Proceedings of the 60th Shock and Vibration Symposium, 
1989. 

19. Shin, Y. S. and Santiago, L. D., “Surface Ship Modeling and Simulation:  2D 
Analysis,” Journal of Shock and Vibration, Vol. 5, No. 2, 1998, John Wiley & 
Sons, Inc. 

20. Naval Postgraduate School Technical Report, “Sea TENTACLE,” January 2006. 

21. XYZ Scientific Applications, Inc., TrueGrid Manual, Livermore, California, 
1997. 

22. Hibbitt, Karlsson & Sorensen, Inc., ABAQUS User’s Manual, Version 6.6 

23. Shin, Y. S. and Ham, I., “Damping Modeling Strategy for Naval Ship System,” 
Proceedings of the 74th Shock and Vibration Symposium, San Diego CA, 27-31 
October 2003. 

24. Schneider, N. A., “Prediction of Surface Ship Response to Severe Underwater 
Explosions Using a Virtual Underwater Shock Environment,” Master’s Thesis, 
Naval Postgraduate School, Monterey, California, 2003. 

 

 

 



139 

INITIAL DISTRIBUTION LIST 

1. Defense Technical Information Center 
Ft. Belvoir, Virginia  
 

2. Dudley Knox Library 
Naval Postgraduate School 
Monterey, California  
 

3. Mechanical Engineering Department Chairman, Code ME  
Naval Postgraduate School 
Monterey, California 
 

4. Naval/Mechanical Engineering Curriculum Code 74 
Naval Postgraduate School 
Monterey, California 
 

5. Prof. Young S. Shin, Code ME/Sg   
Department of Mechanical and Astronautical Engineering 
Naval Postgraduate School 
Monterey, California 
 

6. Research Assistant Prof. Jarema M. Didoszak, ME/Di 
Department of Mechanical and Astronautical Engineering 
Naval Postgraduate School 
Monterey, California 

 
7. LTjg Hakan Ucar 

Turkish Navy 
Istanbul, Turkey 
 

8. Dr. Jeff Cipolla 
ABAQUS, Inc. 
Providence, Rhode Island 

 
9. Karl D’Souza 

ABAQUS, Inc. 
Providence, Rhode Island 
 

10. Dibyendu Datta 
ABAQUS, Inc. 
Providence, Rhode Island 
 
 
 



140 

11. Frederick A. Costanzo 
Underwater Explosion Research Department (UERD) 
Naval Surface Warfare Center – Carderock Division 

 West Bethesda, Maryland 
 

12. Hans U. Mair 
Institute for Defense Analysis 
Alexandria, Virginia 

 
 

 


